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Preface

This manual describes how to use The Palace User Software for the Macintosh and be 
a member of The Palace community. Is is designed to get the new users up and 
running, guide advanced users thought the more advanced Palace features, and serve 
as a reference for the client graphical interface.

Sections of this manual

This manual has the following sections.If you need to find a specific subject, use the 
index at the end of the book. 

• Introduction

This section introduces the community and client software for The Palace.

• Getting Started

This section guides you through installing your software, and describes all 
elements of interface.

• Connecting to Palace Sites

This section explains how to connect to different Palace sites so you can start 
exploring community for The Palace application.

• How to Use The Palace

This section explains features and how to use them: your avatar, talking to and 
finding other people, props, and moving around.

• The Palace Client Interface

This section is a reference for graphical interface, describing its menus, tools, icons, 
and keyboard shortcuts.

• The PalacePresents Viewer

This section describes the PalacePresents viewer. This plugin allows you to take 
part in large-scale networked events, such as conferences, guided web tours, 
slideshows, live interviews, lectures and other one-to-many interactions.

• Advanced Features

This section describes advanced features that you will want to try when you get 
more acquainted with The Palace: special commands, Iptscrae, and creating 
member rooms.

In addition, a number of appendices are included:

• Appendix A: Community Standards
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• Appendix B: User Command Summary

• Appendix C: The Palace Client Plugin API

Manual conventions
This manual has the following conventions:

• Code samples and text you enter are set in Courier , whether standing alone or 
embedded in the text.

• Technical terms appear in boldface italic in the text in their first appearance, 
usually accompanied by a definition. 

• Graphical User Interface (GUI) elements, such as menu items and buttons, appear 
in boldface.

• References to other books, chapters, or sections are in italics.

NOTE – Notes to the user look like this.

Other sources of information
Besides this User's Guide, you can use many other related manuals for administering 
your personal server, becoming an operator, and mastering Iptscrae. These manuals are 
all available from The Palace website section.

• Server Guides. These manuals tell you how to obtain, install, setup, and run your 
own Palace server. Macintosh, Unix, and Windows 95/98/NT versions are 
available.

• Operator Guide. Describes the responsibilities of an operator, and details the client's 
operator interface and commands.

• Iptscrae Language Guide. This manual is a programming and language reference 
guide for the Iptscrae language used in The Palace.

In addition to online manuals, check out The Palace website for support, information, 
and online documentation at www.thepalace.com .
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1 Introduction

Welcome to The Palace - a vast online community of graphical interactive sites. With 
The Palace User Software client as your gateway, the variety of Palace destinations you 
can explore is limitless. You can visit a diverse range of communities such as business, 
training, and learning resources; entertainment and gaming centers; gathering points 
for special interest groups; and personal sites where you can go to chat and socialize 
with friends and family. If you download The Palace Server, you can even build and 
customize your own personal Palace site to host other people. An eight-user version is 
available for free on the Palace website: www.thepalace.com .

One of the best things about The Palace is that it is an open system, letting you create 
and control much of your site’s content. The Palace User Software client not only 
functions as a front-end to browse the Palace community, but also does double-duty as 
a full-fledged authoring tool. By using the built-in "operator powers", available Palace 
tools, and the Iptscrae scripting language, you can create your own virtual world and 
share it with others. The system also ensures that all Palace sites can be interlinked. 
This means that you can build new rooms and sites, then connect them to other Palace 
sites using various networking options. You can even create links between Palace sites 
and web pages, making it all that much easier for people to find you!

The Palace community is a client/server system, with Palace sites running on 
individual computers, local area networks, and the Internet. You enter a Palace site 
through your Palace client, which is designed to communicate with any Palace server 
running on another (or even the same) computer. This is similar to the way your web 
browser interfaces with "webservers" while surfing the Internet.

The Palace allows users to communicate effortlessly over various types of networks. 
You can run your Palace software on  a TCP/IP-based LAN, using AppleTalk,  or on 
the Internet via a SLIP or PPP connection. Palace sites running on Local Area Networks 
hooked to the Internet will allow interaction between people on the LAN and folks 
coming in via the Internet.
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2 Getting Started

This section describes how to get started using your Palace client:

• Requirements on page 11

• Installing The Palace client software on page 13

• Logging on for the first time on page 19

• The Welcome Palace on page 20

• Logging off on page 22

Requirements

This section details the requirement for running The Palace User Software client on 
your Macintosh.

Software
The Palace client software has the following requirements:

Computer: Color Macintosh with System 7.1 or higher. To run the PalacePresents 
viewer, you need Macintosh System 7.6 or better.

NOTE – You will need Appearance Manager in order to use The Palace User Software. 
Appearance Manager is included in System 8 and higher. If you are currently using an 
earlier system, Appearance Manager will be installed automatically along with the 
client.

Monitor: High color, supporting at least 800x600 pixels.
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RAM: At least 16 megabytes. 

Disk space: The Palace requires about 3 megabytes of free hard disk space for storing 
its required programs, datafiles, pictures and sounds. If you plan on traveling to other 
Palace sites, you should know that many of these servers make use of original artwork 
and sounds. As you enter new rooms in these servers, you will need additional hard 
disk space to store these additional assets.

Browser: In order to access all Palace sites, you need a web browser. Either Netscape or 
Internet Explorer version 4.x or greater is required.

Connectivity: To access Palace sites, you need at least a 28.8 kbps internet connection. 
In general, if you can use a web browser, you should be able to use The Palace. There 
are a number of different ways to get connected to a PalaceServer:

• To use The Palace with a modem over the Internet, you will need a SLIP or PPP 
connection to an Internet Service Provider. You may establish this connection using 
FreePPP, MacPPP, or just about any Internet connectivity software.

• To use The Palace on a Local Area Network (LAN) or on the same computer as the 
Palace server, all you need is your standard TCP/IP connectivity software, and you 
are ready to go.

• To use The Palace on an AppleTalk network, you and the PalaceServer must be on 
the same AppleTalk network. You will not be able to connect to PalaceServers on 
other AppleTalk networks or on the Internet.

Accessing Palace sites from behind a firewall
If your computer is running on a LAN inside a firewall, you might not be able to 
connect to Palace sites outside the LAN. If you have problems connecting, your 
network administrator needs to make the following two firewall changes:

• Permit TCP/IP connections on a particular port (usually 9998). The Palace 
software uses TCP/IP to establish a reliable connection to a Palace server that is 
listening on a particular port. When you use The Palace to connect, you specify the 
name of the server (for example, thepalace.com ) and the port (usually 9998). Note 
that the port number can vary for servers but most servers use the default 9998. 

The software sends a TCP/IP connection established message over that port to the 
server. However, firewalls often prevent communication over all but a few well-
known ports. Therefore, to allow The Palace to make contact with servers, the 
network administrator must configure the firewall to permit internal workstations 
to establish TCP/IP connections on the specific port (usually 9998).

• Permit incoming packets on that same port over established connections. Once 
The Palace establishes a connection to the server, the software and server send 
packets back and forth over the Palace port (usually 9998). However, firewalls 
often prevent incoming packets from other than well-known ports. Again, the 
network administrator must configure the firewall to permit incoming packets over 
the specific port (usually 9998) on established connections. 

The key to permitting incoming packets is that the firewall should not allow them 
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except when the connection has already been established by an internal 
workstation. This minimizes the security risk of hackers trying to break into the 
LAN, because someone inside must establish the connection first. The firewall also 
must permit outgoing packets over the specific port on established connections. 
This usually happens as a result of permitting TCP/IP connections over the port. 

NOTE – In LANs where workstations are not directly connected to the firewall but 
instead are connected to a proxy, the network administrator might need to perform 
additional configuration steps to allow packets through on these ports.

Installing The Palace client software

NOTE – Before using the Palace client, you should obtain a registration code to unlock 
the full features of the software. This code is free. Be sure to register before you 
download. You can access the registration form from the software download page by 
clicking Register Now.

Do not give out your registration code. A Palace server does not allow two users with 
the same code to connect at the same time. This means if somebody else uses your 
code, you might be locked out of Palace sites all over the Internet. 

The Palace client contains several related files including executable programs, 
graphics, sounds, prop files and script files. All of these assets are distributed in a 
single, self-extracting archive file.

To obtain Palace client software, go to the website at http://www.thepalace.com/
downloads.  Select The Palace User Software, then choose the correct Macintosh 
version. This steps you through the registration process and then downloads the install 
file to your machine. Click on this file to begin installation.

After the software installs, the Palace client launches automatically. You can choose to 
enter your registration code at this time to become a full-fledged member. The 
registration code was emailed to you after you completed the registration form online. 
If you choose not to register at this time, you can register later by selecting Enter 
Registration Code from the File menu.

Updating your software
The Palace upgrades are released fairly regularly. Be sure to visit the Palace website 
periodically for updated versions. This is how to do it:

1. Determine which version you are currently using. To do this in the finder, click the 
Palace icon in your Palace folder, then select Get Info from the Macintosh File 
menu.
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2. To grab the newest updated version (or just to check for one), select Software 
Updates from the Help Menu. This will launch your web browser and send you to 
the appropriate page on the Palace website.

3. Download the current software executable to your machine, and install it. Make 
sure you choose the current Palace installation as your install folder.

Setting up InternetConfig
This version of The Palace fully supports InternetConfig. You can use the 
InternetConfig options to set up your email information, protocols for web browsers, 
file mappings, and default web browsers. Setting up most of the options is standard 
and is therefore not covered in this manual. This section explains how to add The 
Palace application and set up sound (MIDI) support for the SoundApp application. If 
you are using MacOS 8.5 or later, use the Internet Control Panel.

NOTE – InternetConfig is a public domain application and was not developed by 
Electric Communities. For additional information about InternetConfig, see http://

www.quinn.echidna.id.au/Quinn/Config/ and http://www.stairways.com/ic/ . 
InternetConfig version 2.0.2 is compatible with MacOS 8.5. Also, many applications 
support InternetConfig.

Adding The Palace
To add The Palace:

1. Open the :The Palace:InternetConfig2.0.2  folders. Then, double-click Internet 
Config to display the Internet Preferences dialog box. Note: If the dialog box does 
not open, select Open Internet Preferences from the File menu.

2. Click Helpers to display the Helpers dialog box.

3. Click Add to display the Add Helper dialog box. 
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4. Enter palace  in the Helper For text box. 

5. Click Choose Helper, locate The Palace, and then click Open to return to the Add 
Helper dialog box.

6. Click OK. Your dialog box should now look like this.

7. Click OK.

8. Choose Save from the File menu to apply your changes.

Adding MIDI support
This procedure explains how to set up InternetConfig to route .mid and .midi files to 
the SoundApp application. Once you have set up MIDI support, you can type, for 
example “)titanic.mid” and the sound file (if located in your Media  folder) plays in 
SoundApp. You can also use the SOUND command to retrieve or play files. This is 
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done using room scripts or command lines (for example, /”titanic.mid” SOUND). (For 
details or to download SoundApp, see 
http://www-cs-students.stanford.edu/~franke/SoundApp ).

NOTE – Though the MIDI support is now compatible for the Macintosh and PC client, 
the MIDISTOP Iptscrae command will not work with this revision of Macintosh client.

Keep the following issue in mind when using MIDI files:

• To script a single command that works for both Mac and PC, use “filename.mid” 
SOUND. Users for both platforms can then simply type “)filename.mid” to play a 
midi file. 

To set up MIDI support for SoundApp (the steps are the same for choosing any other 
sound application):

1. Install the SoundApp application, if necessary. See 
http://www-cs-students.stanford.edu/~franke/SoundApp  to download 
SoundApp.

2. Open the :The Palace:InternetConfig2.0.2  folders. Then, double-click 
Internet Config to display the Internet Preferences dialog box. Note: If the dialog 
box does not open, select Open Internet Preferences from the File menu.

3. Click File Mappings and then scroll down the list and click .mid in the left side of 
the dialog box.
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4. Click Change to display the Mapping Entry dialog box.

5. Click Plain Text, change File Creator to SCPL, enter SoundApp in the text box 
below Choose Example, and click Post Process.

6. Click Simple Text to find the SoundApp application.
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7. Click the application and then click Open to return to the Mapping Entry dialog 
box. It looks like this now.

8. Click OK.

9. Repeat steps 3 to 8 for the midi extension.

10. Choose Save from the File menu to apply your changes.
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Logging on for the first time 

Logging on for the first time

You are now ready to log on to a Palace site and start socializing with other members! 
Your client is automatically launched when you first install it. If you exited and now 
wish to log on again, select Programs:The Palace:Palace from your Windows Start 
menu.

Logging on as a registered member of The Palace
Use this procedure if you already have or wish to get your free registration code.

1. Your client is automatically launched when you first install it and displays the 
Welcome dialog box. If you exited the application, click the Palace icon on your 
desktop to display the Welcome dialog box.

2. Click one of the following options to log on as a registered member:

• Get FREE code: Click this option if you do not have your registration code. 
Once you fill out the registration form and click Submit, you will get an email 
response with your registration code within an hour. Once you have received 
the code, continue with Activating your membership on page 20.

• Enter code: Click this option if you already have your registration code and 
then continue with Step 3.

3. If you clicked Enter code in Step 2, the Palace Membership dialog appears.

4. Enter your name, organization name, and then the free registration code sent to 
you by email in the Name, Organization, and Membership Activation text fields 
respectively.

NOTE – Do not give out your registration code. PalaceServers will not allow two users 
with the same number to connect at the same time. This means that if someone else 
uses your key, you may be locked out of Palace sites all over the Internet.
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5. Click Register. 

Logging on as a guest
Use this procedure if you do not wish to register at this time. Note that you can view 
and use a limited set of features if you are a guest.

1. Your client is automatically launched when you first install it and displays the 
Welcome dialog box. If you exited the application, click the Palace icon on your 
desktop to display the Welcome dialog box.

2. Click Stay a Guest.

Activating your membership
To insert your registration code, follow these steps:

1. If you are connected to any Palaces, disconnect from them by selecting Disconnect 
from the File Menu. Note that you cannot enter the registration code while 
connected to a PalaceServer.

2. Double-click the Palace icon to start your Palace software. 

3. Pull down the File menu and select Activate Membership.

4. A dialog box will appear prompting you for your Name, Organization and 
Registration code. Enter this information, and click Register. 

Once this is complete, you are a member of The Palace. 

The Welcome Palace

You access the Welcome Palace as your first site. Your first entryway is the Welcome 
Palace gateway. 

Learning on your own with the Welcome Palace Gate
When you enter the Welcome Palace gate using The Palace User Software, the Web 
browser on your machine also launches to the Palace's web page, where you can find 
links to other exciting Palaces. Note that if you later enter the Welcome Palace using a 
bookmark under the Bookmarks menu, you enter a different room and the web 
browser is not automatically launched. 

The Welcome Palace gateway is private, and you are the only user. You can use this 
room to get comfortable with the basic layout of the Palace software user interface. 
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The Welcome Palace 

The Welcome Palace gate has several links:

• Avatar Dispenser

• Palace Web page 

• Practice Palace

• Welcome Palace Site

NOTE – The Welcome Palace gateway is your default entry to the Palace community 
until you change it. See Connecting to Palace Sites on page 25 for information on 
bookmarking Palaces, connecting to new Palaces, and creating a Home Palace from the 
Edit:Preferences window.

Avatar Dispenser 

In The Palace, your onscreen representation is referred to as your avatar. You first 
come into the Palace wearing a default avatar. Use the Avatar Dispenser to change 
your appearance.

To change your image, click on the Avatar Dispenser's Change your appearance 
button. The image that represents you will change. Continue clicking this button until 
you find an image that you like. You can also click the Back button to go back to a 
previous Avatar. The Dispenser will loop back to the beginning after displaying the 
final avatar.

If you would like to change your appearance again later, go to the Avatar Palace. To 
go to this Palace, select Avatar Palace from the Bookmarks menu.

Palace Web Page

Clicking this link opens a new browser window displaying the Palace Channels Guide.  
Here you can find links to hundreds of other exciting Palaces, and lists of Events held 
in Palaces.

Installing The Palace User Software automatically launches your Web browser to this 
web page. You can use this button to relaunch your web browser if you have closed the 
web page.

The Practice Palace

Click this link to access the Practice Palace. This is an interactive tutorial that teaches 
you how to do different things in the Palace. When you are finished, click the Palace 
icon (P) to go back to the Welcome Palace gateway. You can return to the Practice 
Palace by selecting Practice Palace under the Bookmarks menu. 
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Entry to the Welcome Palace

Click this link to enter the Welcome Palace itself and socialize with others. The 
Welcome Palace is a site for new users, where you can meet people and learn more 
about the Palace community in general. 

NOTE – To make navigating through the Welcome Palace easier, try viewing door 
outlines. To see the door outlines, hold down the control key.

Talking, moving around, and other actions
Here is a list of some things you’ll want to do next in the Palace. For other ideas, see 
the Quick Reference on page 79.

• To talk to people, click on the Input Box at the bottom of your screen (typing will 
usually activate the Input Box, but you may first have to press the Tab key activate 
the Input Box), type something, and press Enter. Your text will appear in a cartoon-
balloon near your head. Talking and balloons is described in more detail in Talking 
to people on page 37.

• To move around, see Moving around on page 40.

• You can personalize some of your Palace settings; for example, you can 
automatically display user names and have tinted word balloons. Use the 
Edit:Preferences menu item to customize these session in your Preferences 
window (see Preferences on page 50).

• If you would like to get a new avatar look, you can visit the Avatars palace. To go 
to this Palace, select Avatar Palace from the Bookmarks menu.

Logging off

There are several ways to leave your current Palace site:

• To go to another Palace, see Connecting to Palace Sites on page 25.

• To disconnect from any Palace site, but not shut down the Palace User Software, 
select Disconnect from the File menu. You are able to still access Palace features 
such as editing props.

• To disconnect and close the Palace User Software altogether, select Quit from the 
File menu.
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3 Connecting to Palace 
Sites

There are a number of different ways to access Palace sites. This section explains the 
options available to you:

• If you already have a Palace client running on page 25

• From your web browser on page 26

• Returning to a recently-visited Palace on page 27

• Using AppleTalk on page 27

If you already have a Palace client running

If you are already running the Palace client, there are several ways to connect to 
different Palace sites:

• Select Connect... from the File menu. This displays the connection window. In this 
window, either select from a drop-down list of Palaces, or type the address 
including port number of a new Palace (for example, 
test.communities.com:9997 ) , or the machine's IP address (such as 
205.999.99.99 ). Note that if you do not enter a port number, the default port 
number 9998 is automatically used. Then, click Connect.

NOTE – You cannot manually enter an address to a specific Palace room from your 
Palace client. However, some Palaces might have hot-spot links to other rooms; you 
can click on these hot spots to go to those rooms.

If you want to connect to your own server that is on the same machine, use 
AppleTalk. Select Connect via AppleTalk from the File menu. Click the server to 
connect to, and then click OK.
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• Your connection window also recalls in the Hostname field, the names and port 
numbers of the last ten Palace sites you visited; select one of these sites from the 
list, and enter it by clicking Connect. 

• The Preferences window lets you set a Home Palace where your Palace travels will 
always begin (like a Home Page on the world wide web). Select Preferences from 
the Edit menu to access this window.

• Some Palace sites have hot spots in their rooms that link to other Palaces. If you 
know about one of these hotspots, you can click it to go directly to that Palace.

• Select one of the Palaces listed in the Bookmarks menu. To add the Palace you are 
currently visiting to your bookmarks list, select Add palace to Bookmarks in the 
Bookmarks menu.

From your web browser

You can access Palace sites directly from the web if you know the address. You do not 
need to have your client running before entering a Palace site; it is launched 
automatically. 

• In your web browser, enter the address of the Palace you want to visit in the format 
machine.domain  (for example, palace://test.communities.com ), or the 
machine's IP address (such as palace://205.999.99.99 ) .

• A Palace site operator might even give you an address to access a specific room in 
that Palace. This address includes the Palace server address, room ID, and optional 
port number (if the port number is not specified, your Palace client will assume it 
to be 9998). To go to that room, enter the address in your Web browser. 

This example illustrates the extended URL specification, where 89 is the room ID 
on the Palace server located at mansion.thepalace.com  (port 9997). 

palace://mansion.thepalace.com:9997/89

NOTE – Using the port number and room ID might not work if you are using Internet 
Explorer. 

• The Palace website (www.thepalace.com ) has several links that take you to Palace 
sites.  

• Periodically, certain Palaces are spotlighted in a Featured Palaces area.

• You can browse the list of the Top 100 Palaces.

• The Palace Site Directory lists all registered Palace sites (if they choose to be 
listed), even those which are not up and running. You can search for a specific 
Palace, choose one alphabetically, or browse Palaces by category (such as 
business or recreational). 
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You can also access the Palace Directory from your private Palace Portal (see 
Logging on for the first time on page 13), or by selecting Palace Directory from 
your client’s Bookmarks menu.

If the Palace User Software icon appears next to the Palace listing (the red P), 
you can click it to go to that Palace. Or, click the Palace link itself to bring up 
its site page. From the site page, click Go using The Palace Software.

• Users might include Palace links on their profile pages; you can then click these 
links to go to that Palace. For information on accessing a user’s profile page, see To 
see somebody else’s profile page on page 32

Returning to a recently-visited Palace

In the Hostname field the Connect dialog box recalls the names and port numbers of 
the last ten Palace sites you visited; you can select one of these sites from this list, and 
enter it by clicking OK. Select Connect... from the File menu to access this dialog.

The Edit:Preferences window also lets you set a Home Palace where your Palace 
travels will always begin (like a Home Page on the world wide web).

If you bookmarked the palace, you can select the name of that palace from your 
Bookmarks menu.

Using AppleTalk

To sign on via AppleTalk, double-click the Palace icon on your desktop.

1. Select Connect Via AppleTalk from the File Menu.

2. A dialog box displays listing the computers on the AppleTalk network that are 
currently running the PalaceServer (your own computer will be listed here as well, 
even if it is not running the server). Select the computer you want to connect to, 
then, under Palace Server, select the palace you wish to connect to, and click OK.

Using other online services

If you do not have a direct connection to the Internet, no need to worry: a number of 
online services provide a level of Internet access suitable for running The Palace. These 
services include AOL and CompuServe. 
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▼ To log on through CompuServe

1. Login to CompuServe and use the GO feature to go to the CompuServe PPP Utility 
area (GO CIS:CWE-35 ). 

2. Select and read "Setting up a Macintosh Internet Connection," which explains how 
to obtain and setup MacTCP, MacPPP and the CompuServe PPP Utility.

3. After completing all of the steps detailed in "Setting up a Macintosh Internet 
Connection," launch Palace and connect to a PalaceServer. MacPPP should 
establish the necessary connection automatically. 

4. If you follow all of the directions in "Setting up a Macintosh Internet Connection" 
and still have trouble connecting, you can get help in the MacCIM Support Forum 
(GO MCIMSUP). 
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4 How to Use The 
Palace

This section describes various features of The Palace and how to use them:

• Avatars on page 29

• Talking to people on page 37

• Paging an operator on page 39

• Playing sounds on page 39

• Moving around on page 40

• Props on page 41

NOTE – In your Palace client, you might see different menu items for member versus 
guest features. Ignore these; if you have registered, you are a member.

Avatars

Your onscreen representation is referred to as your avatar. You first come into The 
Palace wearing the default avatar, which is a spherical yellow happy face sometimes 
known as a roundhead or a yellowhead. You can change expression and face color on 
your roundhead avatar. Later, you might want to edit the look of this face, or get a new 
avatar completely.
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Changing your name
When you first log on to The Palace, your default name is Guest. You can change your 
avatar name through the connection window which you access when you log on to the 
Palace client, or select Connect from the File menu. Enter the new name and click 
Connect.

You can also change your name in the Name field of your Preferences window (select 
Preferences from the Edit menu) or by selecting Avatar Name from the Avatars menu.

Changing your face color and expression
You can change the expression and color for your default roundhead avatar through 
the Face Picker window. To access this window, click the Face button at the bottom of 
the screen or select Guest Avatars from the Avatar menu.

Beneath the array of thirteen expressions in this Window you will see a palette of 
sixteen colors. Clicking on one of these colors causes your face to change to that color. 
Face colors can be used to great effect in signifying emotional states, especially when 
used in conjunction with appropriate expressions (for example; red plus the angry face 
or blue plus the sad face.)

From this window, click the expression you want and your roundhead avatar wears 
this new expression. You can keep this window while moving around in The Palace, so 
you can change your appearance almost instantly.

You can also type these expressions directly into your Input box at the bottom of your 
client (if it is not activated, press the Tab key or click on the box first) window and then 
press Enter.

When you 
type:

You get:

:) or ) Happy

:( or ( Sad

:| or | Normal
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Customizing your roundhead avatar
You do not have to keep your plain roundhead as your avatar. The Palace provides 
many standard props you can wear to customize your avatar. To change your avatar 
image altogether, see the next section, Creating a new avatar on page 32. 

• To update your roundhead by wearing new props, bring up your prop window 
(described in Your Prop Picker window on page 41) and select from your props 
which ones you want to wear. You can then save this avatar look through an avatar 
macro in your Avatars menu (see The Avatars Menu on page 54), where you can 
access it quickly in the future.

• You can customize your avatar even further by coloring it and changing its look. 
Use the Prop Editor to do this (described in Creating and editing props with the Prop 
Editor on page 43.)

Profile pages
Your Profile Page is a web page providing information such as your name, email 
address, favorite Palaces, and interests to other users. Every registered Palace user has 
a profile page. These are listed online at The Palace website’s Profile directory.

▼ To edit your own profile page

1. From your Palace client’s Edit menu, select Edit Profile Page.

Or

2. Access the Profile Page Settings form. From here, you can edit settings such as 
your name, interests, and a brief bio. Some special notes:

• You can link to Palace site pages and other users’ profile pages by entering 
their ID’s. If you do not know the specific ID for that person or Palace, click the 
Lookup link. When a user clicks on that link on your profile page, he or she 
accesses that person’s profile page, or that Palace’s site page.

• You can display a picture on your profile page, either your own or one 
provided by The Palace. If you use your own image, it must be hosted on a 
web server and be available even when you are not online. In the Picture URL 
field, enter the URL where the image is located.

;) or ; Winking

:[ or [ Angry

When you 
type:

You get:
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• You can elect to not list your Profile page on the Profile directory, or prevent 
people from knowing where you are in the Palace at any given time. These 
fields are at the bottom of the Settings page.

3. When you are finished, click Update My Profile Page at the bottom of the form.

4. Click Edit My Palace Interests to update your list of interests.

▼ To see somebody else’s profile page 

1. Hold down the Option key and click on their avatar.

Or

2. Select the user in the User List window (command + f to open) and click on 
profile.

Or

3. From The Palace website, click Profile Directory to access the profile lookup page. 
On this page, you can search for the user by name or profile ID.

4. Once you have accessed that person’s profile page, you can do the following:

• Visit their palace by clicking the Palace link under My Palaces. To use your 
Palace User Software client, click the red encircled P.

• Send them email and visit their home web page by clicking the links under 
Mail and Home Page.

• Join them in the Palace community if they are online by clicking join me!.

• Visit their favorite Palaces by clicking the Palace link under faves and 
raves:Palaces.

• See the profile pages of their friends by clicking the user name under Palace 
Buddies:

Creating a new avatar
The Palace lets you completely replace your roundhead with a new image for your 
avatar. You import your new avatar image as a graphic file, which you then save as a 
prop. Depending on how big this avatar prop is, you either save it in your prop 
window and wear it like any other prop, or save it as a grouped collection of props in 
your Avatar macro window.

An avatar is really just a collection of props, including at least one face prop (a prop 
that replaces the default roundhead image). This head prop serves as a centerpiece for 
the rest of the avatar. A prop measures 44 by 44 pixels; an avatar can contain up to 9 
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props (132 by 132 pixels). You can create your own avatars by importing bitmap 
graphic files that meet these size criteria. There are two ways to create your avatar, 
depending upon the size of the original image you’ve selected.

Single-prop avatars

If your avatar image is no larger than 44 by 44 pixels, it can be made into a single prop:

1. Open the desired image using any graphic editor.

2. Although The Palace automatically selects the closest available colors when you 
paste in a graphic, you should pre-apply the 8-bit Palace Palette to the image while 
still in your graphic editor. This lets you fine-tune your graphics and avoid any 
undesired color shifts. The Palace Palette is free. It can be extracted from any of the 
default graphics provided with The Palace, or downloaded from the Palace 
website. To extract the palette from a default graphic, consult the instructions in 
your chosen graphics editor.

3. When your graphic is ready to import to The Palace, copy it into your machine’s 
clipboard.

4. In The Palace, open the Prop Editor. You do not need to be connected to a Palace to 
open this window. To open the Prop Editor, open your prop window by clicking 
the suitcase icon at the bottom right of the Palace View screen, and then click New 
on the resulting prop window. Or, select New Prop from the Props menu (after you 
bring up the prop window). 

5. Make the image into a face prop. Macintosh users do this by selecting Face Prop 
from the resulting Prop Edit menu. 

6. Save your new prop by selecting Save on the Prop Editor. It now appears in your 
prop window, where you can wear it as a new prop. It will completely replace your 
current avatar.

Multiple-prop avatars

Your total avatar image can contain up to 9 props; that is, it can be up to 132 x 132 
pixels in size. The following diagram illustrates the total available area in which props 
may be worn: a square made up of nine single-prop-sized squares.



34 The Palace User Software Guide for Macintosh

4    How to Use The Palace

The Edit Menu contains a command called Paste Multiple Props. Use this option to 
create an oversized prop by pasting a single image:

1. Open the desired image using any graphic editor.

2. Although The Palace automatically selects the closest available colors when you 
paste a graphic in, you should pre-apply the 8-bit Palace Palette to the image while 
still in your graphic editor. This will allow you to fine-tune your graphics and 
avoid any undesired color shifts. The Palace Palette is free. It can be extracted from 
any of the default graphics provided with The Palace, or downloaded from the 
Palace website. To extract the palette from a default graphic, consult the 
instructions in your chosen graphics editor.

3. Select the area you want to use as your avatar, and copy it into your machine’s 
clipboard.

4. In your Palace client, select Paste Multiple Props from the Edit Menu. The 
oversized image will automatically be cut into individual props and placed in your 
prop window. You don’t need to be connected to a Palace to do this, and you don’t 
need to open your Prop window. This command is not available while the Prop 
Editor is open.

5. The new avatar image is pasted into the prop window as individual 44x44 props 
(not necessarily in order).

6. If you want to edit an individual prop pane before wearing it, select it and click 
Edit to edit in the prop editor. In fact, you will want to make at least one of these 
props into a head prop. When the desired image is in the prop editor, select Face 
Prop from the Prop Edit menu (this menu appears when the Prop Editor is open). 
Save your new head prop by clicking Save on the Prop Editor.
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7. Save this grouped prop as a new avatar look just as you would any other avatar 
look by selecting Save Avatar from the Avatars menu. You can then wear it at any 
time by selecting it from the Avatars menu. See the next section, Saving and wearing 
your new avatar on page 35.

NOTE – No matter what size your avatar is, the default behavior of cartoon balloons is 
to appear from a point near the middle of the central cell (the position of the 
roundhead in the Prop Editor). Depending on where you want these cartoon balloons 
to appear from when you speak, you might want to place the individual pieces of your 
avatar manually.

Saving and wearing your new avatar
An avatar is a specific “costume,” including face color, expression and any props worn. 
If you have a "look" you like (for example, you are wearing special props, or have a 
new avatar image altogether), you can store this look for quick access when you want 
to change your appearance.

You do this through the Avatar Macro window. To display this window, select Member 
Avatars from the Avatars menu. This window lets you store up to 80 avatars and 
instantly recall them, either by clicking in the listbox provided, or with the following 
key combinations followed by the numbers 0 to 9:

• Command

• Shift + Command 

• Control + Command

• Option + Command 

• Shift + Option + Command 

• Shift + Control + Command 

• Shift + Control + Option + Command 

• Control + Option + Command

NOTE – Some Shift key combinations only work if you are using the keypad on the 
extended keyboard or the Avatars Menu. On MacOS 8.5 - 8.6 you cannot access the 
shift and shift-control avatar set from the keypad, though they can still be accessed 
from, the Avatar Macros window. Hotkeys that cannot be accessed from the keypad 
are displayed in parenthesies in the Avatar Macros window.

The Avatar window is divided into three parts, as shown in the following window. The 
scrolling list in the center of the window contains a slot for each Shortcut Key (these 
function as hotkey combinations for ultra-speedy changes). In addition, the list 
indicates which avatar slots are currently in use and which are available.
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• Browsing for Avatars. To view an avatar without wearing it, click on its slot in the 
Shortcut Key list. The saved avatar image on the right side of the window will 
instantly change to display the selected avatar. Selecting an empty (“available”) 
slot displays a default groggy-faced roundhead. You can scroll through the 
window manually, or use the command key with the up/down arrows. To scroll a 
page at a time, use shift + command with the up/down arrows.

• Wearing an Avatar. To wear a selected avatar, click Wear . The current appearance 
image on the left side of the window will instantly change to duplicate the selected 
avatar.

• Saving an Avatar. To save your current appearance in an avatar slot, select an 
available slot from the Shortcut Key list (or an in use slot that you want to 
overwrite), and click Save. The saved avatar image on the right side of the window 
will instantly change to duplicate your current appearance.

Animating your avatar
You can animate your avatar (for example, have a blinking eye). You do this through 
your prop edit window. 

Palace avatars have a fixed animation rate, and checking the Anim field of an 
individual piece will make the piece animate in rotation with any other of the pieces in 
the avatar that also have the Anim box checked. Since each avatar has a total of up to 
9 pieces, 9 is the maximum number of "frames" that can be animated in one avatar. 
Note that you must have two or more props marked Anim to do this.

Most people just animate a "section" of an avatar. For example, they will take a six-
piece avatar, and decide to animate something specific, such as an earring or winking 
eye. Use the following steps to do this:

1. Animate the avatar piece containing the prop you want to animate by marking it 
Anim in the prop edit window.

2. Save that change.
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3. On the prop edit window, click Dupe to duplicate the prop. This duplicated prop 
will already have Anim checked. When both pieces are worn, they will animate.

4. You can use step 3 to make additional animating pieces.

NOTE – There's no elegant way to animate two completely different sections of one 
avatar, since they will alternate and produce a choppy effect.

Another setting in the edit window that can affect animation is the Bounce setting. If 
the animating pieces don't have Bounce checked, they will animate in the order they 
were put on in rotation, (1,2,3,4,1,2,3,4,1,2,3,4 etc.) If Bounce is checked, the pieces go 
back and forth(1,2,3,4,3,2,1,2,3,4,3,2,1 etc.) Sometimes this can enhance the animation 
effect, and sometimes it's better not to use it. Experiment and see what works best for 
your prop.

Talking to people

The primary activity on any Palace site is conversation between people. Therefore it is 
not surprising that The Palace software provides you with a number of ways to express 
yourself.

The most commonly used form of speech is called talking. Talking is represented by 
normal text, appearing in a cartoon-balloon near the speaker’s head (or center-most 
prop). To talk, click on the Input Box at the bottom of your screen (usually typing 
automaticaly activates the Input Box, but you may first have to press the Tab key 
activate the Input Box), type something, and press Enter. Your text will appear in a 
cartoon-balloon near your head.

You can control the length of time text stays up on your screen by setting the Balloon 
Delay, which can be found under Preferences on the Edit Menu. From there you can 
also control the Font and Font Size used in all cartoon-balloons.

Special balloons
The default state of your cartoon-balloons is the normal talking balloon.

Of course, talking in a normal manner sometimes does not get your point across quite 
the way you mean it. For these situations, the Palace provides you with several 
additional types of cartoon-balloons, including shouting balloons, thinking balloons 
and rectangular sign balloons.
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To change the type of balloon used to display a typed message, use special characters 
in front of your typed text. The following table explains how to activate the various 
balloon types, and illustrates their effect on an example message (“my message”).

Whispering and ESP (private messages)
By clicking directly on another person’s avatar, you enter Whisper Mode. All other 
avatars on the screen become slightly darker, and the phrase You are talking to: 

name appears in the Status Bar (name indicates the name of the targeted user). At this 
point the person you have clicked on has no idea that they have been selected. To 
whisper to this person, simply type your message into the Input Box as usual. Both 
you and the other party will see your message appear on the screen in italics, but no 
one else will see the message. Subsequent messages continue to be private, until you 
de-select the person by clicking on the Status Bar, clicking on their avatar a second 
time, or selecting another person. 

The Palace software also allows you to whisper to people in distant rooms; this is 
called ESP. To do it, simply open the User List window (by selecting Find User from 
the Options menu) and click once on the name of the person you wish to speak to. 
Regardless of their location, they will see your message in italics (and no one else will). 
To turn whispering off, click on the status bar.

NOTE – Sounds and Special Balloons do not work in ESP Mode.

Balloon Type via Input Box

: my message
Want to give people a piece of your mind? This gives you a thought 
balloon, instead of the normal talking” balloon.

^ my message
This gives you a rectangular sign balloon, that stays up until you 
move or say something else. Useful for saying things like BRB (Be 
Right Back).

! my message
This gives you an excited-looking spiky balloon. Useful for 
shouting.

@x,y my message
Allows you to spoof by placing your balloon wherever you want it 
(e.g., “*100,200 my message”). X cannot exceed 512. Y cannot 
exceed 384. NOTE: The spoofing capability is disabled on many 
Palaces.
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Keeping track of conversations with the log window
The Log window records a log of your session, including all conversations and actions 
by avatars in your room. The Log window displays by default; you can close it just like 
any other window. To open it again, select  from the Options menu.

Paging an operator

Operators are the authority figures of the Palace community; they tend to be either the 
owners of the site in question, or individuals who have been granted special powers 
and capabilities by the owners. In either case, a major concern for most operators is 
keeping the peace, and they possess an arsenal of commands allowing them to do just 
that. Operators are able to disconnect unruly users at will, or cause them to be banned 
from the site indefinitely. They can even ban whole domains if they decide it is 
necessary. In short, they are very powerful people.

Operators are also interested in making sure their site is viewed as a popular and 
hospitable place. For this reason many operators are happy to take a little time out of 
their day to explain the basics to a new user, or to help out with a tricky scripting task.

If an unruly user is harassing you, or even if you just want a hand with some aspect of 
the site you are visiting, the best thing to do is page the local operators. Use ‘page 

messagetext  command, which consists of the word ‘page , followed by an optional 
message explaining the reason for your page. For example:

‘page Is there a website where I can get all the sounds for this Palace?

This statement, typed into the Input Box, will send your question to all operators 
currently logged on to the local Palace site.

NOTE – This command should be used sparingly, and only when you actually do need 
help of some kind.

Playing sounds

The Palace has a built-in set of audio files that everyone can use. These files are located 
in your Sounds  folder (which is within the Media  folder). 

To play a sound, type a right parenthesis followed by the name of the sound:

)applause

You can even follow a sound with spoken text:
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)applause She shoots! She scores!

The list of built-in sounds includes amen, applause, belch, boom, crunch, debut, fazein, 
guffaw, kiss, no, pop, teehee, and yes. 

In addition to these standard sounds, many Palace operators add their own sounds to 
their own Palace sites. By default, these sounds download into Sounds  folders beneath 
the Palaceroot :Media: PalaceName  folders, although many of them are also available 
via the world wide web, you must copy them into the appropriate folder. If you have 
some sounds you would like to use at any Palace site, simply move (or copy) them to 
your : Palaceroot: Media: Sounds  folder. Remember, however, that only users who 
possess the same sounds themselves will be able to hear them when played.

Moving around

There are several ways to move around in The Palace in a specific room:

• With your mouse, click on any spot in the room. Your avatar moves to that spot.

• Use the arrow keys to make small vertical and horizontal moves. If the Input Box 
is currently active, the arrow keys will not work this way; press the Tab key to 
toggle focus back to the View Screen. Also, be careful about abusing this feature. 
Continual arrow-key movement causes considerable and unnecessary strain on the 
Palace server, and may get you kicked off many Palace sites. 

To move to other rooms or Palaces, use one of the following methods.

Spots and doors
Although the various ways out of rooms are usually clearly marked, sometimes they 
are not. In a Palace site, any wall hanging or crystal ball might be a portal to another 
room. If your cursor changes to a hand while over an area, a door is present. When you 
click on a door, you are immediately transported through it (if it is open). Note that 
using the arrow keys to move onto a door does not activate the door. Doors go to 
rooms inside your current Palace.

To show door outlines, press the Control key.

Rooms can also have hot spots. You can click on these spots to go to other Palaces, 
send your web browser to a web site, or start a scripted event.

When you click on a door, you are immediately transported through it (if it is open). 
Note that using the arrow keys to move onto a door does not activate the door.
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Jumping to a specific room
Another convenient way to move is to use the Goto Room command from the Options 
Menu (hotkey combination Command-G). This opens the Room List window. Note 
that you will only be able to enter rooms that are public and unlocked using this 
feature.

Joining a specific user
If you are looking for a particular user on the current Palace site, you can use the Find 
User command in the Options Menu (hotkey combination Command-F) to find them. 
This opens the User List window. Double-click on the user’s name to join them 
wherever they are. Or, select their name and click Go.

Going backwards
You can select Go Back from the Options menu to return to rooms you previously 
visited. Note that you cannot use the Go Back command to move between Palaces; it 
can only be used to return to previously visited rooms in the same Palace.

Props

A prop is an object that can be worn near or placed over your face, a small graphic 
object that you can hold (like a baseball bat or a cup) or attach to yourself (like a hat, a 
pair of sunglasses or a wig).

Palace members are able to pick up any loose props they find lying around, no matter 
what Palace site they happen to be in. You can keep these props in your Prop Picker 
window. You can even create and edit your own customized props, so you can create a 
new look for your avatar. 

NOTE – When copying a prop in PropEdit, any changes made to the background color 
will be included in the image sent to the clipboard.

Your Prop Picker window
Props are often employed in combination; up to nine props may be worn on your 
avatar at one time. Props are put on, taken off, edited, saved and deleted through your 
Prop Picker window.
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The Prop Picker window

To access the Prop Picker window, click the suitcase icon at the bottom right corner of 
your Palace client window.

Once the prop window is open, you can double-click on any prop to put it on, and 
double-click on it again to take it off. As long as the window remains open, the Props 
menu displays on the menu bar.

General prop actions
A loose prop is one that you find lying in a room, not attached to any avatar. You pick 
up, wear, and store these props in your prop window. You can also leave loose props 
for other people to use. The easiest way to create a loose prop is to put it on (by 
double-clicking on it in your Prop Picker window), then pull it off your face, and drag 
it into the room.
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There are several things you can do with loose props:

Creating and editing props with the Prop Editor
You can edit existing props, and create new ones using the Prop Editor. For detailed 
information on the Prop Editor interface, see The Prop Editor on page 60.

Editing an existing prop

From your Prop Picker window, select the prop to edit and click Edit. (If you want to 
keep the original copy of the prop, make sure you duplicate it first by selecting 
Duplicate Props from the Props menu.) The Prop Editor appears, displaying the 
selected prop. At the same time, the PropEdit menu appears on the menu bar. In the 
prop editor, you can color and change the look of the prop using the prop drawing 
tools. 

Creating a new prop

You can use the Prop Editor to quickly and easily create new props by pasting in 
graphic images from any graphic viewer or editor. This is very similar to creating a 
new avatar image.

▼ To create a new prop

1. Open the original image using any quality graphic editor, and copy it.

Action How to do it

Move prop Select the prop with your mouse cursor and drag 
it around. You will notice that you can't actually 
put a prop on somebody else; they have to pick it 
up and decide to wear it. Similarly, you can't grab 
a prop that somebody else is wearing; they must 
give it to you by dropping it (of course, it is 
possible to grab props by doing a screen 
capture...)

Put prop in prop window Drag the prop to your prop window. 

Put on prop Drag the prop onto your avatar. This also adds 
the prop to your prop window. 

Put copy of prop in your prop 
window

This takes only a copy of a loose prop (leaving 
the original behind). Hold down the Option key 
while you drag the prop to your prop window.

Delete prop Drag it to the Trash Can at the bottom right 
corner of the screen.
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2. In The Palace, open your Prop Picker window and click New to open the Prop 
Editor.

3. Paste the image in the Prop Editor (Paste from the Edit Menu, or Control-V).

4. Save your new prop by selecting Save in the Prop Editor.

If the picture is up to 44 x 44 pixels (the size of a single prop), it will appear in full. If 
the image is larger, only the upper-left 44 x 44 pixels will be pasted into the area.

Changing the position of your prop

While the Prop Editor is open, the arrow keys on your keyboard can be used to move 
the image around, relative to the central position of the roundhead. The total area 
allowed is equal to 9 prop-sized squares, arranged in a single 3 by 3 square. Any prop 
can be saved while occupying any position in this large square, and the prop’s position 
will be saved as well.
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5 The Palace Client 
Interface

This section describes the general structure of this interface, and explains the terms 
used to refer to it:

• Elements of the main window on page 45

• The Menus on page 48

• Keyboard shortcuts on page 57

• Using the Drawing Tools on page 58

• The Prop Editor on page 60

Elements of the main window

The Palace screen has the following features:
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Interface Elements

The View Screen
The Palace interface is dominated by a large rectangular area known as the View 
Screen. This is where all graphic action takes place. As you move from room to room 
within a Palace site, the View Screen is filled with a picture representing the 
background of that room. All avatars and props in the room appear superimposed on 
this background.

NOTE – Room Graphics and Download Time. Most Palace sites use at least one or two 
pieces of original art. When you enter these rooms, the pictures are automatically 
downloaded into the Pictures  folder located inPalace:Media:PalaceName . For 
example, the pictures for “The Super Palace” are placed in:Palace:Media:The Super 

Palace:Pictures .

If you already possess the graphics for the room you are entering (that is, if you’ve 
been there before) The Palace will display that room graphic. This takes place almost 

Status BarInput box

View
 screen

Icons
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instantly. If you enter a room you’ve never seen before, however, you’ll have to wait 
for the room’s background image to download; a process which generally takes 15 to 
60 seconds on a 28.8 k baud modem. While the image is downloading, the room’s 
background will be black and a progress bar will appear in the bottom part of the View 
Screen, indicating the status of the download. Props and avatars, being smaller in 
filesize, will usually become visible before the room’s background pops into place.

The Input Box
The long, thin box beneath the View Screen is known as the Input Box. This is where 
you type in anything you want to say (Palace members can enter Iptscrae commands 
from this box as well). To activate the Input Box, type in it.

The Status Bar
The area just between the Input Box and the View Screen is known as the Status Bar. 
The Status Bar typically displays the following information:

• The name of the current room.

• The number of people in the current room/the number of people in the current 
Palace

• The name of the person you are talking to if you are in Whisper Mode (see Talking 
to people on page 37).

Under certain conditions the Status Bar will display error messages (when the 
connection is refused, for instance, or when the server goes down). The Status Bar may 
also be scripted (by the "operators" of a site) to display specific messages, greetings, 
marquees, and other text.

The Icons
To the right of the Input Box are four icons: a Face, a suitcase, Paint Palette, and a Trash 
Can. These icons are used to activate features that operate independently of the 
windows.
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The Menus

This section describes the functions of all menu commands in the Palace interface.

The File Menu
The File Menu contains commands for entering and leaving The Palace. In addition it 
contains file-oriented commands, such as logging your conversations and saving your 
avatars.

Connect...

This command is used to sign on to a Palace server. Clicking here will cause a dialog 
box to appear, asking for the address you wish to connect to. The last 10 Palace 
addresses you have visited appear as choices in the drop-down list. 

Connect via AppleTalk

This command is used to log onto a Palace server running on an AppleTalk LAN.

Disconnect

Disconnects you from the current Palace site without closing The Palace.

Button Description

The Face
Clicking on this icon opens the Face Window, allowing you to 
change your facial expression and color.

The Suitcase
Clicking on this icon opens the Prop Picker window, giving you 
access to your current collection of props (allowing you to add 
props to your avatar or remove props from your collection). 
Members can also use the Prop Picker window to edit existing 
props or create entirely new ones.

The Paint Palette
Clicking on this icon opens the Painting Window, giving you access 
to a number of special tools used for painting on the screen. This 
function is turned off in some Palace rooms. NOTE: Guests are able 
to look at the tools in the Painting Window, but are unable to use 
them. Such are the benefits of membership!

The Trash Can
This icon allows you to dispose of unwanted items: dragging a 
prop here gets rid of it. Clicking on the Trash Can does nothing.
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Close

Save

Log to File... | Stop Log 

This command opens the Log File. A Log File records all chat text and typed 
commands to a file on your hard disk.

Child Lock

This command brings up a dialog box that allows you to set a password to child-
protect The Palace. Do not forget this password—you will be asked to supply it every 
time you launch The Palace.

Reload Script

This command reloads your CYBORG.IPT file—the only Palace datafile you can edit 
while online. You can edit your CYBORG.IPT file at any time with any text editor 
(running in another window), save it and return to The Palace, but your changes will 
not become effective until you select Reload Script.

Activate Membership

This command allows you to activate your member registration code. You can register 
for membership when you download the client software. Membership is free. 

Quit

This command disconnects you from the current Palace and closes the program.

The Edit Menu
The Edit Menu contains the standard editing commands, as well as the important 
Preferences window.

Undo

This command allows you to undo your most recent action. If only all of life had an 
undo command!

Cut

This command allows you to cut text from the Input box or the Log window. This 
command can also be used for graphic functions, such as when working in the Prop 
Editor. The hotkey combination for this command is Command-X.

Copy

This command allows you to copy text from the Input box or the Log window. This 
command can also be used for graphic functions, such as when working in the Prop 
Editor. The hotkey combination for this command is Command-C.
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Paste

This command allows you to paste text into the Input box from anywhere. This 
command can also be used for graphic functions, such as when working in the Prop 
Editor. The hotkey combination for this command is Command-V.

Paste Multiple props

This command allows you to paste oversized graphics into the Prop window, where 
they are divided into individual props. 

Select All

This command selects the entire contents of the Log window or the Input box for 
copying. Note that the Log window or Input box must first be selected (that is, it must 
be the active window).

Edit Profile Page

This launches your web browser and takes you to your Profile settings page. Here, you 
can update the settings on your user profile. See Profile pages on page 31 for more 
information.

Preferences

This command brings up the dialog box shown below, allowing you to set the 
following options:
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• Name 

This is the name that others see attached to your face. You can see the nicknames of 
others in the room by simultaneously holding down the Command and Option 
keys.

• Balloon Delay

This control allows you to modify the length of time that cartoon balloons are 
displayed on the screen. Three durations are available: Long, Medium, and Short. 
The duration of any message is based upon the length of the message, modified 
(locally) by this setting.

• Font 

This allows you to set the font used to display the text in cartoon balloons, user 
names and hotspot names.

• Size 

This allows you to set the size of the font used to display the text in cartoon 
balloons, user names and hotspot names.

• Use Fade Effects 

This checkbox enables or disables the transitional fade effect that causes your 
Avatar to fade out when leaving a room and fade in upon entering.

• Download Graphics

This command, when checked, instructs Palace to request images for new rooms 
you enter. If unchecked, new rooms will appear black in your View Screen.

• Prop Animations 

This command allows you to view animated props (multiple-frame sequences of 
props which create the illusion of motion or action). If not checked, only the first 
frames of animated prop sequences will appear.

• Tinted Balloons

When checked, this command causes all cartoon balloons to appear filled with 
color.

• Show User Names 

This command allows you to toggle the display of user names in the View Screen. 
You can make these names appear temporarily by holding down the Command 
and Option keys.

• Palace Starts With

This field lets you set the Palace site you start with by default. All Palace addresses 
have two parts: a server name (URL) and a port number. The two input boxes in 
this area allow you to enter this information to connect to the specified Palace site. 
This area also includes some shortcuts to help make connecting even easier. You 
can also set a Home Palace that will be entered automatically whenever you launch 
Palace (just like a Home Page in your web browser). To do this, click Home Palace, 
and type in the address and port number desired.
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Note that the port number (to the right of the Palace Server Address proper) is set 
by the Palace Operator of the site in question: it is almost always 9998. If you 
cannot get into a Palace Site at all, contact the Server Operator and make sure 
you’re pointed at the correct port number.

The Options Menu
The Options Menu contains various commands for controlling the behavior of the 
software, as well as several means of transportation throughout Palace sites.

Draw

This command opens and closes the Drawing Palette.

Show Names

This command allows you to toggle the display of user names in the View Screen. The 
default for names is on. You can make these names appear temporarily by holding 
down the Command and Option keys simultaneously.

Don’t Update User List

When the User List window is open, the list updates automaticaly as users log on and 
off. This command freezes the list until you uncheck it.

Floating Log Windows

This command allows the log window to float in the tool window layer. Your change 
will not take effect until the next launch of The Palace.

Sound Volume...

This command opens the Sound Volume control.

Speak As...

This command displays a submenu of available voices from the Speech Manager.

Full Screen

This command toggles between a full-screen display and a windowed display.

Iconize

This command minimizes The Palace without disconnecting, reducing the display to 
an icon on your desktop. 

Go Back

This command moves you back to the previous room visited. The hotkey combination 
for this command is Command-B.

Log Window

This command toggles the Log Window open and closed. This is a floating window 
that stores all text messages you receive (both speech and special messages). This text 
can be saved to disk by selecting Log to File… from the File Menu. The hotkey 
combination for this command is Command-L.
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Find User...

This command toggles the User List Window open and closed. (Hotkey is command+f)

This window displays a list of all users logged into the current Palace Site, and the 
names of the rooms they are in. Clicking on a user’s name in this window causes you 
to enter Telepathy Mode with that person; you can now speak to them just as though 
you were whispering. To instantly teleport yourself to another person’s location, 
double-click on their name, or select their name and click Go. To see another user ’s 
profile page, select their name and click Profile.

GoTo Site Page...

This launches your web browser and takes you to the site page of the Palace you are 
currently visiting.

Goto Room...

This command toggles the Room List Window open and closed. 

This window displays a list of all rooms in the current Palace Site, and the number of 
users in each room. To instantly teleport yourself to another room, double-click on its 
name, or select the name and click Go. Exception: rooms marked Private cannot be 
entered (except by operators and owners). The hotkey combination is Command-G.
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Plug-ins

This command accesses your Plugins Submenu, allowing you to run any Palace 
Plugins installed on your system. This menu includes an entry for each of your Palace 
Plugins—small programs that enhance the functionality of Palace. To appear in this 
menu, your Plugins must be installed in the : Palaceroot :Plugins  folder (this is 
where they are installed by default). 

Operator

This command opens a dialog box asking for the operator (or owner) password. 
Operators and owners have special powers and capabilities beyond those of registered 
members; there are different operators and owners (and passwords!) at each Palace 
Site. If the password is entered correctly, the Operator Menu is added to your menu 
bar. The hotkey combination is Command-Option-W.

The Avatars Menu
Guest Avatars

Select this option to bring up the Face Picker window. See Changing your face color and 
expression on page 30 for more information.

Member Avatars...

Select this option to bring up the Avatar Macros window. See Saving and wearing your 
new avatar on page 35 for more information.

Change Avatar Name...

Select this option to change your avatar name. 

Animate Avatars

Select this option to animate any avatars that can be animated.

Alternate Avatar Window

Select this item to display a compact version of the Avatar Macros window. 

The Operator Menu
This menu appears when you enter operator or owner mode (select Operator from the 
Options menu, then enter the operator or owner password). The Operator Menu 
provides access to a set of advanced functions beyond the needs and rights of typical 
Palace members. Operators and Owners are the managers and proprietors of the 
various sites in The Palace network. Anyone with a Palace Server (and an IP address or 
AppleTalk network) can open a Palace site and become its owner, and then give the 
site’s operator password out to trusted individuals. Therefore, each Palace site has at 
least one owner, and most possess operators as well.
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NOTE – The Operator Menu appears on your menu bar only if you are currently an 
operator or owner on the Palace site in question.

The commands in this menu provide operator (or owners) with various superpowers 
in the form of special commands and authoring control over their Palace sites. Since 
using these commands requires an in-depth understanding of the Palace server 
software, this topic is not treated here. For information on operator commands and the 
operator menu, see The Palace Operator's Guide.

The Props Menu
This menu appears when you have the Prop Picker window open (click the suitcase 
icon at the bottom right corner of your screen). It has the following menu items:

New Prop

The New Prop selection brings up the Prop Editor, ready to create a new prop.

Edit Prop

Opens the Prop Editor to edit the selected prop.

Duplicate Prop

Makes a copy of the selected prop in your prop window.

Delete prop

Deletes the selected prop.

Purge…

The Purge selection deletes all cached props older than 24 hours that are not currently 
being used. Note that it does not purge the props visible in your Prop Picker window.
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The PropEdit Menu
The Propedit Menu is visible when you have the Prop Editor open. To open the Prop 
Editor, open the Prop Picker window first by clicking the suitcase icon on your screen. 
Then, either edit or create a prop from the Props menu or the Prop Picker window.

Face Prop

Use Face Prop to indicate a prop that takes the place of the roundface.

Ghost Prop

This creates a prop that is partially transparent. Any prop can be a Ghost Prop.

Rare Prop

A Rare Prop can not be copied. It is removed from your prop bar when it is dropped as 
a lose prop. 

Animate 

An animated prop is like a frame in a small movie; when worn, it rapidly flashes on 
and off. If more than one animated prop is worn, they will flash in sequence. The order 
of the sequence can be modified by the Bounce setting. 

Bounce

If this option is checked for any prop you are wearing, your animated props will cycle 
on and off in "palindrome" fashion ("forward-backward_forward), instead of looping in 
the forward direction all the time.

White Background

Gives your prop a white background which copies with the prop to the clipboard.

Gray Background

Gives your prop a gray background which copies with the prop to the clipboard.

Black Background

Gives your prop a black background which copies with the prop to the clipboard.

Flip Horizontal

Flips your prop horizontally.

Flip Vertical

Flips your prop vertically.
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The Bookmarks Menu
The Bookmarks Menu displays a menu option to bookmark your favorite Palace sites 
and a set of interesting Palace sites you can visit. To add a site to the list, connect to the 
site, and then select Add palace to Bookmarks from the Bookmarks Menu. The sites 
that you bookmark are added to the end of the default list. You cannot delete sites from 
the Bookmarks Menu. 

Note that we do not recommend manually editing the bookmarks file. The Palace 

Bookmarks  file is usually located in the :System Folder:Preferences folders. You 
can move the bookmarks file to your Palace  folder for easy access. Note that if you do 
edit the file manually, your changes will not appear until you exit and relaunch The 
Palace.

The Help Menu
The Help Menu consists of a number of links that, when clicked, will take you to the 
appropriate page at The Palace website. The topics covered include:

Quick Reference

Tutorial

User Guide

FAQ

Software Updates

Discussion Groups

Communities.com

Keyboard shortcuts

The following keyboard shortcuts are available to all users:

Key Description

Tab key Toggles focus between the Input Box and the View Screen. 

Up Arrow 
key

When the focus (see above) is on the Input Box, this pages 
back through your previously typed statements. When the 
focus is on the View Screen, the arrow keys allow you to 
move your avatar around on the screen.

Down 
Arrow key

When the focus (see above) is on the Input Box, this pages 
forward through your previously typed statements. When 
the focus is on the View Screen, the arrow keys allow you 
to move your avatar around on the screen.
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Using the Drawing Tools

The Palace client provides room drawing tools, where you can paint and draw in the 
room you are currently visiting. Both the room and the Palace site must have Painting 
privileges set on for you to do this. 

To access the drawing tools, click the Palette icon on your View screen. Or, select Draw 
from the Options menu.

Only members may use these tools, and everybody in the room sees whatever is 
painted. (Exception: Operators and owners can turn painting off in particular rooms, or 
on a site-wide basis. Some Palace operators consider painting to be a nuisance activity, 
and prefer to turn it off completely.)

Esc key Clears the Input Box. 

Command 
and Option 
keys

If the Autoshow Names option is unchecked (in the 
Preferences Dialog Box), this hotkey combination 
temporarily displays the names of all people in the current 
room. If Autoshow Names is checked, this combination 
causes the names to temporarily disappear.

Control key When held down, this key causes the outlines of all doors 
in the current room to become visible.

Command 
and Up/
Down 
Arrow Keys

When the focus is on the Avatar Macros window, these 
keys allow the user to scroll up and down through the 
avatars.

Shift, 
Command 
and Up/
Down 
Arrow Keys

When the focus is on the Avatar Macros window, these 
keys allow the user to scroll up and down through the 
avatars a full page at a time.

Key Description
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The Drawing Tools

The following Drawing Tools are available:

Tool Description

Pencil | 
Filled region

This tools lets you draw in various colors and line sizes. It 
has two states: Pencil and Filled Region. The Pencil tool is 
active when no colored area appears around the pencil. 
The Filled Region tool (activated when a colored area does 
appear around the pencil operates similarly, but turns the 
region drawn into a closed shape.

Detonator When you click this button, it deletes the last line that was 
drawn, whether it was created by hand or by a script. 
Double-click this button to delete all drawing on this 
screen.

Layerer You can draw either behind or in front of avatars. Click 
this button to toggle the pen between these two layers.

Pencil | Filled region

Line Sizer

Detonator

Layerer

Palette



60 The Palace User Software Guide for Macintosh

5    The Palace Client Interface

The Prop Editor

The Prop Editor lets you create and edit images for props and avatars. Like the room 
drawing tools, it has a set of drawing tools and a color palette. To access the Prop 
Editor, open your Prop Picker window by clicking your suitcase icon at the bottom of 
the screen. Then, click New from the Prop Picker window, or select an existing prop 
and click Edit. If you hold down the option key while pasting a new image into the 
Prop Editor, all pixels that match the currently selected background color (see the 
PropEdit menu section) will be masked out so that only the non-background color 
pixels will be drawn in the prop

The following picture shows the Prop Editor tools:

Line Sizer This button changes the width of the Pencil and Filled 
Region tools. The center diagonal line is the current width. 
To increase the line size, click the line in the upper right 
corner. To decrease the width, click the line in the lower 
left corner.

Palette The Palette tool lets you select a drawing color from the 
Palace palette.

Eyedropper Although not visible as a tool, there is an eyedropper tool 
available for selecting colors directly off the screen image. 
The cursor changes to an eyedropper when you press both 
Option and the mouse button simultaneously anywhere in 
the View screen, no matter which tool is selected. The 
color that the cursor is pointing to becomes the current 
drawing color. This is useful for extending a particular 
color you see on the screen.

Tool Description
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The Prop Editor Interface

To close the window and save your work, click Save. To close without saving, click 
Cancel.

Some of these tools have special functions, or respond differently when certain key 
combinations are pressed. The following table describes the prop editor's tools and 
fields.

Tool Description

The Pencil 
Tool

Use this tool for drawing or editing details. To constrain 
the pencil to a straight line, hold down the Shift key while 
drawing. To turn the pencil into a paint bucket, hold down 
the Control key. To turn the pencil into an eyedropper for 
picking up colors, hold down the Option key.

The Eraser 
Tool

Use this tool to create transparent areas. Note that erased 
portions are transparent; they allow whatever is behind 
them to show through. To create transparent areas in 
solid-colored areas of your prop, hold down the Control 
key.

Pencil Tool

Selector Tool

Eraser Tool

Line Sizer Tool

Palette

Prop Name



62 The Palace User Software Guide for Macintosh

5    The Palace Client Interface

Prop Edit menu options
When the Prop Editor is open, the Prop Edit menu appears. For descriptions of these 
options, see The PropEdit Menu on page 56.

The Selector 
Tool

Use this tool to move or delete sections. Click and hold 
down the mouse button down at one corner of the desired 
area, drag to the opposite corner (with the mouse button 
still depressed), and release. The selected area may now be 
moved around, or removed with the Delete key.

The Line 
Sizer Tool

Use this tool to change the pencil and eraser size. The 
diagonal line in the center of this button indicates the 
current size of the pencil and eraser. To increase the line 
size, click in the upper-right corner of the button. To 
decrease it, click in the lower-left.

The Palette Select the color you want activate; that is, the one the 
pencil will draw with.

Prop Name Enter a name for the prop if desired. You can then use this 
name in scripts. For Palace members the prop's name may 
be especially important, since there are Iptscrae 
commands that can be used to manipulate props as long 
as their names are known.

Tool Description
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6 The PalacePresents 
Viewer

This section describes the PalacePresents Viewer:

• What is PalacePresents? on page 63

• What you need on page 64

• Starting the PalacePresents Viewer on page 64

• Joining an event on page 66

• Attending an event on page 67

• The Viewer Toolbox on page 69

What is PalacePresents?

This Palace Plugin allows you to take part in large-scale networked events such as 
conferences, guided web tours, slideshows, live interviews, lectures and other one-to-
many interactions. The PalacePresents software creates a multipurpose stage that is 
hosted on an existing Palace site. This stage appears in a separate window from The 
Palace. The interesting thing about this stage is that once you are connected to it, you 
can always see it—no matter what room you move to in the host Palace.

The moderator sets up and runs PalacePresents events. You must have the operator 
password to run the Moderator. The viewer allows you to participate in the event 
while it is online. You'll be able to view all events transpiring on the stage, and to ask 
questions of the moderator and others on the stage. You can also keep a log of the 
event and may even be invited onto the stage yourself. 
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What you need

To participate in events via the PalacePresents Viewer, you must be running The Palace 
User Software for Macintosh (version 2.43 or newer). You must have at least 6 
megabytes of RAM; and be using Macintosh System 7.6 or later.

The PalacePresents Viewer consists of two parts, an application and a plugin. They are 
both installed automatically when you install The Palace. The application file, 
PalacePresents  is installed into the Palace folder. The plugin file, PalacePresents 

PPA is installed into the Palace:Plugins:startup folder. 

Starting the PalacePresents Viewer

After starting The Palace, the following steps will get you started with the 
PalacePresents Viewer:

1. To see a list of all your installed plugins (including the PalacePresents Viewer), 
select Options, Plugins from the menu bar. 

2. Click PalacePresents Viewer if there is not a checkmark besides it. 

3. You can also click PalacePresents from your Palace installation folder.

The Event Notification Dialog Box

Your PalacePresents Viewer is now loaded and active. Whenever you launch the 
Viewer while an event is running, or if an event goes on the air while you are running 
the Viewer, the Event Notification Dialog Box will appear, as shown below. Note that 
you will only be notified of events transpiring on the current Palace site.

Click Join to participate in the event. The next thing you will see is the interface of the 
PalacePresents Viewer itself, which is described in Attending an event on page 67.
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Plugin options

The Viewer Menus

As shown in the illustration above, the choices available on the Viewer menus in The 
Palace are not limited to quitting the PalacePresents Viewer; other submenu options 
you can perform here include Preferences (that is, viewer configuration) and Join an 
Event.

Preferences...

The Preferences Dialog Box

The Preferences dialog box, appears when you choose Preferences... from the File 
Menu. This dialog box allows you to set a number of configuration options, controlling 
the manner in which PalacePresents events are displayed and saved (if at all) on your 
computer.

• Always Accept Stage Invitations Without Prompting

If this option is checked, you will be automatically transported to the stage 
whenever you are invited. Leave this option unchecked if you want to change your 
avatar or throw on a few props before you hit the stage.
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• Prompt to Save the Transcript on Exit

If you exit the PalacePresents Viewer, or if the moderator ends the current event 
while you have this option checked, you will be shown a dialog box asking if you 
want to save the event transcript to a file. If this option is unchecked and either of 
these events occurs, the dialog box will not appear, and the event transcript will 
not be saved.

• Show System Messages in Transcript

When this option is checked, additional system information messages are 
displayed in the transcript.

Joining an event

As mentioned previously, if you launch the Viewer while an event is running (or, 
conversely, if an event goes on the air while your Viewer is running), you will be 
notified of the event and given a chance to join the audience automatically. However, if 
you decline the initial invitation notice and then change your mind later, you can still 
get in.

Selecting Join an Event from the Viewer menu displays the Select an Event to Join 
window , as shown below. Here you can select which event you want to join and 
browse any web pages associated with the event. The first column of this list displays 
the names of all PalacePresents events currently running at the PalaceServer you’re on. 
You can join an event in progress by double-clicking its name in this list. 

Showing a list of events with the Select an Event to Join window

• Click Join to join a selected event. You can also join the selected event by double-
clicking the event name.
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• Click Event Info to send your web browser to the page specified under Event 
Information URL.

Attending an event

The PalacePresents Viewer is easy to operate, containing only a few basic elements, 
including the Stage, the Textbox, the Invite/Offstage Button, and the Transcript 
Window. The following illustration indicates the positions of these important elements:

The PalacePresents Viewer Interface

This interface has the following elements

• Stage

This is where the presents appear and speak. It works just like a miniature Palace 
window.

• Textbox

While you’re offstate, the label here reads Submit question. Type your message 
here and hit Return to submit it to the moderator. While you’re onstage, however, 
the label reads Chat and whatever you type is displayed for the entire audience to 
see.

Invite me

Off Stage

Preferences

View Event Info

Save Transcript

Stage

Textbox

Transcript
Window
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• Transcript window

This frame logs all conversation occurring onstage. You can save it to a file by 
clicking Save Transcript.

The PalacePresents Viewer allows you to see the avatars of anyone currently onstage. 
This includes the event presenter (or presenters, if there is more than one), as well as 
anyone else who has accepted the moderator's invitation to come onstage. Note that 
the moderator does not directly appear onstage. Moderator speech appears in a 
standard cartoon balloon in the upper-left corner of the stage area.

Avatars can move around on the stage just as they can in a Palace room, and everyone 
who is connected to the event will see them moving. While onstage, you can wear 
props, even animated props, but you cannot change your avatar without leaving the 
stage again.

NOTE – While you are onstage you also remain in the Palace room you were invited 
from, and a special on stage prop is automatically added to your avatar there. While 
onstage, you can continue to chat and move around in The Palace proper, and can also 
broadcast by typing into the viewer. Thus, you can be in two places at once.

Talking to the stage
Whenever you are not on the stage (and most of us are not on the stage), the label 
above the Viewer's Input Box reads Submit Question. Type here (and press the Enter 
key) to submit your question or comment to the moderator. If selected by the 
moderator, your question will appear onstage, just as you typed it. Note that the 
moderator not only has control of which comments are selected, but can also delay or 
shuffle comments, and may even preload a series of simulated comments prior to (or 
during) the event.

Diehard users will be happy to hear that the viewer’s input box allows you to use 
special balloons just as you can in The Palace itself. By preceding your text with one of 
the following characters, you can change the appearance of your cartoon balloon:
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The Viewer Toolbox

To the left of the stage you will notice a column of five buttons. These buttons comprise 
the Viewer Toolbox, which provides shortcuts for the most commonly-used functions. 
This section describes these buttons and their use.

• Invite Me Button (Members Only)

While you are watching an event (that is, not onstage), clicking on this button means 
Invite Me (while you are onstage this button is disabled). Clicking here sends a 
message to the moderator, requesting an invitation to the stage. Note that if you have 
Always Accept Stage Invitations Without Prompting checked in the Preferences 
dialog box, you will be pulled onstage as soon as your request is accepted. Otherwise, 
you will see the following dialog box, which serves as your official invitation:

Balloon 
Appearance Typed Character Description

: my message This gives you a thought balloon 
(pictured at left), instead of the normal 
talking balloon.

^ my message This gives you a rectangular sign balloon 
(pictured at left), which stays up until 
you move or say something else. Sign 
balloons are useful for saying things like 
BRB (Be Right Back), or for posting a 
long piece of information (like an email 
address or URL), that you want to make 
sure everyone reads.

! my message This gives you an excited-looking spiky 
balloon (pictured at left). Useful for 
shouting.
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An Invitation Onstage

• Off Stage Button

While you are on the stage, the Offstage button becomes enabled. Clicking here 
causes you to leave the stage. 

• Preferences Button

This button causes your Preferences dialog box to appear; it is the same as 
selecting Preferences from the File Menu in the PalacePresents software.

• View Event Info Button

This button launches your web browser, taking you to the Event Information web 
page that has been set up by the moderator. It is the same as selecting Current 
Event Info from the cc menu. 

• Save Transcript Button

This button causes an ASCII transcript file to be saved on your hard disk. It is the 
same as selecting Save Transcript from the Viewer File Menu.
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7 Advanced Features

This section describes advanced features you can use to enhance your Palace 
experience even further:

• Special commands on page 71

• Creating and using member rooms on page 71

• Automating yourself with Iptscrae on page 73

Special commands

The Palace server possesses a number of special commands allowing you to 
personalize your experience online. All special commands consist of text typed into the 
Input Box, and most of them begin with a single backquote ( ` ). 

For a complete list of Special Commands, see Palace Command Summary on page 83

Creating and using member rooms

Palace operators may allow members to create their own rooms. These member rooms 
(as they are aptly called) exist only temporarily, deleting themselves whenever (A) 
there is no one inside and (B) when their owners disconnect from the current server. 
There are number of special commands associated with member rooms. Like most 
special commands, these are typed directly into the Input Box, and begin with a single 
backquote ( ` ).
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`newroom roomName

Creates a new room with a cloudy sky background. If you do not supply roomName, 
the new room will be called “Jim’s room” (or whatever your name is). When you 
create a room you become its owner (similar to being a channel op on IRC), and 
may use all of the special commands listed below within that room. If the room 
empties out and you log off, the room will disappear.

`rdelete

Deletes the room. This command is rarely necessary, as the room will disappear of 
its own accord anyway.

`rowner userName

Allows you to transfer ownership of the room to userName .

`rname roomName

Renames the room to roomName.

`rpicture filename

Allows you to specify a new background picture for the room. You may use any of 
the default Palace pictures, (the bar, the study and the beach are the most popular — 
look in your Pictures folder to see the list). You can use a custom picture of your 
own creation if you wish, but only people who have a copy of that graphic will be 
able to see it; everyone else will see a black background.

`rkick userName

Kicks userName  out of the room. The person will be kept out for the remainder of 
their session, or until ownership is transferred. 

NOTE –  They can get around this by logging off. If you are having a real security 
problem you can either use a password, close the room entirely (see below), or page an 
operator for assistance.

`runkick userName

Cancels the effects of an 'rkick command.

`rpassword yourPassword

Denies entrance to the room except to those who know yourPassword . When 
someone tries to get in, the server will deny access and request that the person 
type 'password yourPassword  to get in. For example, if you create a room and 
type:

`rpassword mojo

Other users will be unable to enter your room unless they type:

`password mojo
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`rclose

Closes (locks) the room, preventing access by anybody except the room owner. If 
everybody inside leaves, the room automatically opens.

`ropen

Opens (unlocks) the room.

`rscripts on

`rscripts off

Turns Iptscrae scripts on and off within the room. Scripts are on by default.   

`rpainting on

`rpainting off

Turns painting on and off within the room. Painting (aka drawing) is on by default. 
The owner can do some painting (to make a sign) and then turn painting off to 
make a temporarily-permanent sign.

`rguests on

`rguests off

Denies access to guests (non-members).

`rhide on

`rhide off

Removes the room from the Room List (for all except operators and owners, who 
can still see it).

`runhide

Cancels the effects of an 'rhide command. Same as 'rhide off .

NOTE – A member room will disappear from the Palace site if it empties out while its 
owner is logged off.
If the room remains occupied, its owner may log off and log back on, and will retain 
ownership of the room.
Member rooms all disappear when the server goes down.
Normally, each member is allowed to create one (and only one) member room at a 
time.

Automating yourself with Iptscrae

As if you didn’t already have enough to keep you happily Palace-hopping for a long 
time, there are many more options available to you once you begin to master the 
intricacies of Iptscrae, the Palace programming language. Your initial introduction to 



74 The Palace User Software Guide for Macintosh

7    Advanced Features

Iptscrae will most likely be in the form of your own cyborg.ipt file (or “Cyborg 
Script”), that contains the routines used to automate aspects of your avatar ’s behavior 
online. This section provides a cursory overview of the contents of the cyborg.ipt 

file, and explains the operation of this file in its default state. For more information on 
Iptscrae, see the Iptscrae Language Guide.

NOTE – Modifying the c yborg.ipt file requires a degree of familiarity with Iptscrae 
that is beyond the scope of this guide. Since the same commands and syntax are used 
to create Palace Server Scripts and Cyborg Scripts alike, would-be authors will want to 
read the Iptscrae Language Guide.

Your cyborg.ipt file
This section describes your Cyborg.ipt file, examining its structure and operation 
line-by-line. To make any changes desired, you'll need to open this file with a text 
editor or word processor capable of saving in ASCII ("text only") format. Always 
remember to make a backup copy before editing your cyborg.ipt file.

The cyborg.ipt file is a script, written in Iptscrae. Scripts contain handlers, which 
respond to events. These handlers are themselves contain short programs called 
atomlists. An atomlist could also be called a subroutine. To get a clearer understanding 
of what this means, let’s take a look at your default cyborg.ipt file.

The INCHAT handler

The first block of statements in your file is your INCHAT handler (as indicated by the 
words ON INCHAT and the open curly bracket in the first line):

ON INCHAT 

{

; expressive prop changes - in response to what others say

{ "Lightbulb" DONPROP { DOFFPROP } 120 ALARMEXEC } CHATSTR "you 
genius" == IF

...

INCHAT is where you store atomlists that respond to words you hear others say; 
atomlists in this handler are triggered by any CHAT event. You’ll notice lots of curly 
brackets throughout the script. These curly brackets indicate additional atomlists. 
Subject to syntax requirements, atomlists can contain other atomlists, but each must be 
opened and closed with the corresponding curly bracket. You can tell when a script has 
reached its end by counting and pairing the open curly brackets with the closed ones. 
You’ll notice that the first open-curly bracket above has no partner. More on that soon...

The line starting with a semicolon (;) is a comment. The software ignores everything on 
the line after the semicolon. Commenting your code is good programming practice, 
and it will save you a lot of time when you come back to this file several months after 
editing it.
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The functional stuff is contained in the IF  statement that follows the comment. This 
statement causes your avatar to don a lightbulb prop for 120 ticks (a tick is about 1/
60th of a second, so this is about 2 seconds) and then remove it, provided someone 
says the trigger phrase appearing in quotes ("you genius" ).

This sample lends itself to fairly easy editing. Without altering the structure of the 
statements or atomlists involved, you can easily edit this IF  statement, or duplicate it 
to have your avatar don different props in response to different trigger statements. Be 
sure your new prop names refer to actual props in your satchel, or your script will do 
nothing. You can also change the number of ticks between donning and doffing the 
prop.

FINGER information. We know the INCHAT handler isn’t done yet, because our first 
open-curly bracket in the cyborg.ipt  file hasn’t been matched with a close-curly 
bracket. The next section, therefore, is also executed on response to INCHAT...

; this is your FINGER information - replace the stuff in quotes with 

; information about yourself.

{

"^<insert name>\x0d"

"<insert e-mail>\x0d" +

WHOCHAT PRIVATEMSG

} CHATSTR "finger" == CHATSTR ";finger" == OR 

  WHOCHAT WHOME == NOT AND IF

}

As the comment tells us, this routine allows you to provide others with some 
information about you when they select you for whisper mode and say “finger”. To 
edit it, simply replace <insert name>  and <insert e-mail>  (including the angle 
brackets) with whatever information you want to put there. If you want to add 
additional information lines, copy the format of the "<insert e-mail>\x0d" +  
(including the plus sign at the end). Unless you’re an Iptscrae expert, you should 
probably leave the rest of this structure alone.

The OUTCHAT handler

If you pair up the curly brackets here you will find that the last one is an extra; we now 
know that we have reached the end of our INCHAT handler. The next block of 
statements comprise the OUTCHAT handler.

ON OUTCHAT 

{

; more expressive prop changes (in response to what YOU say)

{

{ "Lightbulb" DONPROP { DOFFPROP } 120 ALARMEXEC } 30 ALARMEXEC

} CHATSTR "a.* idea" GREPSTR IF
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This is the beginning of your OUTCHAT handler, which contains atomlists that execute 
whenever you say something.  The IF  statement is very similar to the one encountered 
in the INCHAT handler. In this example, the IF  statement evaluates each of your 
outgoing messages to see if it matches the specified target condition (the "a.* idea" ), 
and executes a don/doff  routine if it does.

The “a.* idea”  target condition looks for the letter a, followed by anything, followed 
by the word idea , anywhere in the outgoing message (GREPSTR instead of SUBSTR). 
Phrases like a good idea  and I have an insane idea, man  meet this criteria, and 
will trigger the Lightbulb  prop routine.

ZAP routine. Your OUTCHAT handler also contains a ZAP routine:

; Zap somebody by positioning the mouse and then say "zap"

{ "!)fazein Zap!" MOUSEPOS SAYAT

   255 0 0 PENCOLOR 2 PENSIZE 

   POSX POSY MOUSEPOS LINE 

   PAINTUNDO

  "" CHATSTR =

} CHATSTR "zap" == IF

This zap routine listens for you to say zap , whereupon it quickly performs a series of 
related actions:

1. It plays the fazein  audiofile and places the word Zap!  in a spiky balloon at the 
position of the mouse pointer ( "!)fazein Zap!" MOUSEPOS SAYAT ).

2. It sets the system pen to bright red (255 red, 0 green and 0 blue), and makes it two 
pixels wide ( 2 PENSIZE ).

3. It draws a line (using the pen's current color and size) from your avatar’s position 
( POSX POSY ) to the mouse pointer ’s position ( MOUSEPOS ). This creates a laser 
beam effect.

4. It erases the line ( PAINTUNDO ).

5. It removes your “zap”  statement from the CHAT string, so no one sees it 
( "" CHATSTR = ).

There have been so many variations on this script that it would take a good-sized 
document to list them all. The Zap script is probably the most heavily-edited atomlist 
in the Iptscrae annals. For starters, you might want to experiment with changing the 
target message and the audiofile played, or the color and size of the pen.

Cleaning your room. The next atomlist is useful when a room gets too cluttered to see 
what’s going on.

; clean the room by saying "clean"
{

CLEARLOOSEPROPS
PAINTCLEAR

} CHATSTR "clean" == IF
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This atomlist waits for you to say clean , and then removes all loose props from the 
current room ( CLEARLOOSEPROPS ) and deletes all painted lines on the screen 
(PAINTCLEAR ). 

Spoofing. The next statement is a spoofing atomlist.

; spoof somebody by positioning the mouse on their mouth
; and then typing "msay blah blah"

{ "$1" GREPSUB chatter =
  chatter MOUSEPOS SAYAT
  "" CHATSTR =
} CHATSTR "^msay (.*)$" GREPSTR IF

If you’re into spoofing people (putting words in their mouths), this atomlist makes it a 
lot easier than using the *X,Y function. It waits for you to say anything that starts 
with the word msay. When you do, everything after the word msay is sent to a cartoon 
balloon that magically appears at your cursor's position. It then sets the CHAT string to 
(nothing) so that no one sees your original utterance. This is such a useful routine that 
you should probably keep it just the way it is.

Final OUTCHAT atomlist. Here is the final atomlist in your OUTCHAT handler:

; give another user a prop

{ "$1" GREPSUB who = "$2" GREPSUB prop =

  prop who WHOPOS ADDLOOSEPROP

} CHATSTR "^give (.*) (.*)$" GREPSTR IF

}

We can tell this is the last statement because of the extra closed-curly bracket at the end 
of the sample (which matches the one we encountered on the first line of this handler). 
The routine waits for you to say anything matching the structure of give person  

prop . The first word after give  is called and passed to a symbol called who, while the 
final word is called $2 and is passed to a symbol called prop . A copy of prop  is then 
added to the screen at the position of who. This cannot be used to place a prop on a 
person, but rather puts it right next to them. 

NOTE – If the user specified is not present in the room or the prop named is not in 
your prop file, this routine will not work.

SIGNON handler

Finally, we come to the last handler in your cyborg.ipt file:

ON SIGNON {
"*64,64 !It's " USERNAME + SAY
1 MACRO

}
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This is your ON SIGNON handler, which consists of only one atomlist. When you first 
enter any Palace site, this routine does two things. First it causes you to say 
It’s your_name ! in a spiky balloon at position 64 x 64 on the screen. Next it runs 
"macro" number 1, setting your initial appearance (this is equivalent to selecting the 
first avatar from the Avatars window, or pressing the F1 key).

You’ll notice that the syntax and special characters used to indicate the location and 
style of the announcement are the same as those used in the Input Box to create special 
talking effects. By experimenting with these text-based functions (and the others 
available via the Input Box) you can edit this script to trigger complex strings of text, 
sound and avatar actions whenever you enter a Palace site.
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Welcome to the Palace! Once you’ve installed the software, you’re ready to meet people 
and explore Palace sites. Here are some suggestions on what you can do to get going:

What to do How to do it

Log on for the first time Logging on for the first time on page 19

Connect to a Palace Connecting to Palace Sites on page 25

Ask a Palace operatoroperator 
for help

Paging an operator on page 39

Change your name Changing your name on page 30

Customize your roundhead 
avatar

Customizing your roundhead avatar on page 31

Get a new avatar Creating a new avatar on page 32

Send messages to people Talking to people on page 37

Have a private conversation Whispering and ESP (private messages) on 
page 38

Change your balloon Special balloons on page 37

Find other people Joining a specific user on page 41

Join somebody else Joining a specific user on page 41

Move around within your room Click on the spot where you want to go

Find doors and hot spots to 
other places

Spots and doors on page 40

Go to another room Jumping to a specific room on page 41 and 
Going backwards on page 41

Use props General prop actions on page 42
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Create or edit a prop Creating and editing props with the Prop Editor 
on page 43

Play sounds Playing sounds on page 39

What to do How to do it
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 A  Community 
Standards

After the interface explanations and Iptscrae examples are over, after you’ve become 
confident in your use of Palace and after all the tricks have been taught, there are still 
several important topics that cannot be brushed aside, all of which come down to the 
way people treat each other in the Palace community.

As a new breed of endeavor somewhere between concrete art and abstract science, it is 
certain that the school of virtual environment design still has a long way to go before it 
reaches anything approaching maturity. Unfortunately, the same can be said for a lot of 
people, even out here on the electronic frontier. It takes all kinds, right? Anyway, in 
your travels through the various worlds of The Palace it is not unreasonable to assume 
that you’ll run into a few troublemakers. These people enjoy pushing others for a 
reaction, and their antics tend toward garden-variety spoofing and gutter-variety 
profanity. Alone or in small groups, these cyber-brats often hop from room to room, 
looking for new people to offend.

If you find yourself in such a situation, there are a number of things you can do to 
make it stop (and/or keep it from happening again). But because you do have real 
recourse to real solutions, you need to ask yourself whether this represents truly 
offensive behavior (i.e., such as most people would find offensive), or whether this 
person is simply making momentary use of a Palace feature in a unusually “creative” 
way. Sometimes that line can be hard to draw; even harder when your own emotions 
get into the equation.

It is important not to react in kind when confronted with rude or obnoxious behavior; 
nothing encourages it more. Rather, you should seek at first to distance yourself from 
the offending person. There’s a lot of room out there, and plenty nicer people to hang 
out with. You can always sign off and come back later; disconnection is the better part 
of virtual valor. If the person persists in bothering you, open your log (under the File 
Menu) — it may help later to have a record of their exact words.

Of course, you can always call for divine intervention... At most Palace sites, the 
operators and owners are creative and dedicated people; they create virtual worlds to 
share enjoyable experiences with others like themselves, not to sink to the lowest levels 
of human behavior. And since they all want their sites to be popular, it’s in their 
interest to make sure people feel comfortable during their visit. Within their own sites, 
operators and owners are all-powerful; able to create and destroy rooms, distribute and 
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revoke passwords, and temporarily “kill” or indefinitely “ban” specific individuals (or 
entire domains). If you feel that a certain individual is acting in such a way as to ruin 
the experience for others, let the local deities know about it. That's probably all you'll 
need to do.

The Palace is not the first graphic multi-user domain ever created, but it is probably 
the least strict. Many powers possessed by the average Palace member — painting, 
spoofing and nickname-changing, to name a few — would be withheld for operators 
and owners only on MUDs of other varieties. The way we decide to handle these 
powers determines to a great degree what kind of community we are. These powers 
have been given to all of us as a design decision on the part of Communities.com, but 
it is important to remember that it’s all software; should certain powers prove 
unmanageable or harmful, they may be crippled or removed entirely from subsequent 
versions.

In a way, the whole of the Palace community can be seen as a massive, progressive 
social experiment in which we are all participating. For this reason, we invite you to 
participate in the “Community Standards” Discussion Group. To get there, take your 
web browser out to the "Palace Support" section of The Palace website (http://
www.thepalace.com) and click on the link labeled “Discussion Forums."

Please post your experiences, insights and suggestions for the benefit of all Palace 
users.
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 B Palace  Command 
Summary

The following table provides a list of all special commands (not counting Iptscrae 
commands and keywords):

• Guest commands on page 83

• Member commands on page 84

• Operator commands on page 85

• Owner commands on page 87

NOTE – These commands are current for the Palace Server version 4.4.1. Note that 
some commands are not available on older versions of the Palace server.  For the list of 
which commands are available on the specific server you are connected to, use the 
’help  command.

Guest commands

The following table lists the Palace guest commands.

Guest 
Commands

Syntax Description

help ' help Displays all special commands available to your 
user class, in the Log window

page 'page message Summons help from an operator

sitepage 'sitepage Displays the URL of this Palace’s Site page.
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Member commands

The following table lists the Palace member commands.

Member 
Commands

Syntax Description

hide 'hide on
'hide off

Hides you from all other users
Unhides you from all other users

hidefrom 'hidefrom name Hides you from user name

mute `mute name Mutes user name

newroom 'newroom 
'newroom [roomName]

Creates your member room (one per user)
Creates your member room as roomName

page 'page message Summons help from an operator

password 'password password Specifies a password for navigation purposes

rclose 'rclose Closes your member room to further visitors

rdelete 'rdelete Deletes your member room

re
respond

're message 
'respond message

Replies to the last sender of an ESP message

rejectesp 'rejectesp on 
'rejectesp off

Rejects all incoming ESP messages
Stops rejecting ESP messages

rejectprivate 'rejectprivate on 
'rejectprivate off

Rejects all incoming private messages
Stop rejecting private messages

rguests 'rguests on 
'rguests off

Allows guests to enter your member room
Prohibits guests from entering your member 
room

rhide 'rhide on
'rhide off

Hides your member room from the Room List
Unhides your member room from the Room List

rkick 'rkick name Kicks name out of your member room

rname 'rname roomName Renames your member room as roomName

ropen 'ropen Opens your member room to visitors

rowner 'rowner name Transfers ownership of your member room to 
user name

rpainting 'rpainting on 
'rpainting off

Enables painting in your member room
Disables painting in your member room

rpassword 'rpassword [password] Password-protects your member room

rpicture 'rpicture filename Sets new background for your member room
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Operator commands

The following table lists the Palace operator commands.

rscripts 'rscripts on 
'rscripts off

Enables scripts in your member room
Disables scripts in your member room

runhide 'runhide Same as `rhide off

runkick 'runkick name Cancels an `rkick command

unhide 'unhide Same as `hide off

unhidefrom 'unhidefrom name Unhides you from user name

unmute 'unmute name Unmutes user name

Operator 
Commands

Syntax Description

autoannounce 'autoannounce message Sets the server greeting to message

banip 'banip [minutes] 
ipAddress

Bans one or more IP addresses for minutes.  
May use wildcards (i.e.: 12.24.23.*).

banlist 'banlist [-k] [-a] 
[name|ipAddress]

Shows banned users in log window

banuser 'banuser [minutes] name Bans user name for minutes

bots 'bots on
'bots off

Turn user scripts on server-wide
Turn user scripts off server-wide

comment 'comment ipAddress 
message

Adds a comment to a banlist

death 'death minutes Set default death penalty to minutes

delete 'delete Deletes the current room

duplicate 'duplicate Duplicates the current room

er 'er Moves you to the room of the last (non-
operator) page

extend 'extend string minutes Extends the death penalty on a ban record

flood 'flood number Kill flooders after number events per second

gag 'gag name Gags user name

Member 
Commands

Syntax Description
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glist 'glist [-k|-o| -p| -wl] Lists information on all users
• -k Show the users’s reg key hash
• -o Show the users’ software originiation 

code and machine type
• -p Show the users’ PUID hash
• -w List only operators

kill 'kill [minutes] name Kills (disconnects) user name for minutes

list 'list [-k|-o| -p| -w] 
[name|ipAddress]

Lists information on specific user matching 
name or IP address
• -k Show the users’s reg key hash
• -o Show the users’ software originiation 

code and machine type
• -p Show the users’ PUID hash
• -w List only operators

operatorcount 'operatorcount Displays the number of operators currently 
logged in.

paint 'paint on
'paint off

Turns painting on server-wide
Turns painting off server-wide

pin 'pin name Pins user name

propgag 'propgag name Propgags member name

purgebanlist 'purgebanlist Purges elapsed ban records

purgeprops 'purgeprops number Purges all props older than number days

repage 'repage message Sends message to the last (non-operator) page

roommaxguests 'roommaxguests 
number

Sets the max guest occupancy for the current 
room

roommaxocc 'roommaxocc number Sets the max occupancy for the current room

track 'track [minutes] name Tracks all sign-ons from user name for minutes

trackip 'trackip [minutes] 
ipAddress

Tracks all sign-ons from ipAddress.  May use 
wildcards (i.e.: 12.24.23.*).

unban 'unban name
'unban ipAddress

Unbans user name
Unbans user from ipAddress

ungag 'ungag name Ungags user name

unpin 'unpin name Unpins user name

unpropgag 'unpropgag name Unpropgags member name

untrack 'untrack name
'untrack ipAddress

Stops tracking user name
Stops tracking user from ipAddress

Operator 
Commands

Syntax Description
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Owner commands 

Owner commands

The following table lists the Palace owner commands.

Owner 
Commands

Syntax Description

allowedurls 'allowedurls on
'allowedurls off
'allowedurls "URL"

Enables the allowed URLs string.
Enables the allowed URLs string
Sets the allowed URLs string or strings 
(separated by a pipe (|)).

authoring 'authoring on
'authoring off

Allows operators to enter Authoring Mode
Prevents operators from entering Authoring 
Mode

avatarurl 'avatarurl on
'avatarurl off
'avatarurl "URL"

Sets custom avatars on.
Turns custom avatars off.
Sets the avatar directory to the designated 
URL.

ban 'ban name Permanently banishes name from the server

botkill 'botkill on
'botkill off

Allows cyborg scripts to kill
Prevents cyborg scripts from killing

chatlog 'chatlog on
'chatlog off [filename]

Enables chat logging on the server
Disables chat logging on the server

custom 'custom on
'custom off

Enables custom props on the server
Disables custom props on the server

defaultroomocc 'defaultroomocc 
number

Sets the default room occupancy

downlist 'downlist number Moves the current room number positions 
down in the script file

dropzone 'dropzone Makes the current room a dropzone (front 
gate)

entrypage 'entrypage ["URL"] Sets the Palace’s default entrypage URL for 
the Palace Directory. If keyword 
FORCETPVWEBPAGE is set, it’s also the 
entry page for web clients coming in from a 
non-authorized URL  (TPVALLOWEDURLS 
keyword).

fileserver 'fileserver ["URL"] Sets the location of your media for web-based 
users.

flushprops 'flushprops n Clears old props older than n days and 
compresses the prop file.

guests 'guests on
'guests off

Enables guest access to the server
Prevents guest access to the server



88 The Palace User Software Guide for Macintosh

    

killprop 'killprop Removes the prop you are wearing from the 
server prop file.

maxocc 'maxocc number Sets the maximum server occupancy

memberrooms 'memberrooms on
'memberrooms off

Allows members to create member rooms
Prohibits creation of member rooms

nowhisper 'nowhisper on
'nowhisper off

Disables whispering
Enables whispering

operators1 'operators on
'operators off

Enables support for operators
Disables support for operators

operatorskill 'operatorskill on
'operatorskill off

Allows operators to kill
Prohibits killing by operators

operatorsonly 'operatorsonly on
`operatorsonly off

Sets the current room as operator only
Removes operator-only setting

operatorpass 'operatorpass password Sets the operator password to password

ownerpass 'ownerpass password Sets the owner password to password

passwordsecurity 'passwordsecurity Enables password security (auto-kills after 
three failed password attempts)

picdir 'picdir path Sets the source directory for outbound files to 
path

pinprop 'pinprop 
'pinprop on
'pinprop off

Sets the pin prop to the prop you are wearing
Turns pin propping on
Turns pin propping off

playerkill 'playerkill on
'playerkill off

Allows members to kill
Prohibits killing by members

poundprotect 'poundprotect on|off Enables/disables pound protection. This logs 
the IP address of a user who repeatedly makes 
new connections in a short time interval.)

poundcheckinterval 'poundcheckinterval n Sets the pound check interval to n seconds.

propcontrol 'propcontrol on

'propcontrol off
'propcontrol userlevel

Turns on prop control (only owners can 
introduce new props)
Turns off prop control
Lets only userlevel users introduce new props

purgelimit 'purge number
'purgelimit number

Sets the purge limit to number days
Same as `purge number

recycle 'recycle [number] Causes guest ID numbers to recycle at number 

reportprefs 'reportprefs Lists the current Palace preferences.

reset 'reset Recomputes all rooms’ occupancy count.

revision 'revision Displays the Palace server version number.

Owner 
Commands

Syntax Description
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Owner commands 

1. Be careful in using this command. If you turn this off, and then log off, you will not be able to 
access the  operator interface again later to turn it on/off. You will need to use the 
~susr ownerpassword  command to get back into owner mode.

roomsfile 'roomsfile
'roomsfile .patfilename

Shows current file setting
Causes your Palace to use the template 
asociated with the named configuration file. 
This changes the look and feel of your Palace.

savesessionkeys 'savesessionkeys on
'savesessionkeys off

Enables/disables saving sessions keys (that is, 
logs users’ ID and reg code to the server log).

securejavaaccess 'securejavaaccess on
'securejavaaccess off

If this is on, additional authorization is 
required for web-based users.

securelogoff 'securelogoff on|off If this is on, the authentication engine tracks 
logoffs

securesite 'securesite on|off If this is on, a name and password are 
required to access this Palace server.

security 'security 
authhost:[authport] 
[retrys]|off

Sets the security (authentication) daemon.
• authhost is the daemon’s URL
• authpot is the daemon’s port
• retrys specifies how many attempts a user 

can make. The default is 1.

setrank 'setrank command 
setting

Sets the rank of the command to the specified 
setting.

servername 'servername string Sets the servername to string

showranks 'showranks Displays each Palace command and its current 
rank. Modifications via 'setrank are shown in 
paranthesis.

shutdown 'shutdown Shuts down the server

spoof 'spoof on
'spoof off

Allows members to spoof using @x,y 
commands
Prohibits spoofing

uplist 'uplist number Moves the current room number positions up 
in the script file

Owner 
Commands

Syntax Description
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 C The Palace Client 
Plugin API

The Palace client software has an open architecture that makes it possible for other 
programs, such as games, to plug-in. If you're interested in finding out more in joining 
the developer's program, please go the Partner's page on The Palace website 
(www.thepalace.com ).
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Index

A
Activate Membership 49
activation code 20
Alternate Avatar Window 54
Animate 56
Animate Avatars 54
animated props 51
AOL 27
AppleTalk 48

connecting through 27
audio 52
avatar

animate avatar 54
change appearance 21, 22
change expression 30
change face color 30
change name 30
create 32
create room 71
customize default 31
definition 21
description 29
fading 51
find 53
join 41, 53
move around 22, 40
profile page 50
save favorite looks 54
save look 35
show names 51, 52
talk to others 37
talk to people 22
using audio 52
wear look 35

Avatar Dispenser 21
Avatar Palace 21, 22
Avatars Menu 54
Avatars window 35

B
Background 56
balloon 51

set font 51
set font size 51
shouting 38
sign 38
thought 38
tinted 51
types 37

Balloon Delay 51
bookmarks 57

adding a Palace 26
Bookmarks Menu 57
Bounce 56

C
change

avatar look 31
color 30
expression 30
name 30
prop position 44

Change Avatar Name 54
Channel Guide 21
chat

cut from window 49
log to file 49

child lock 49
color, change 30
command 71
commands 83
Compuserve 27
Connect 48
Connect via AppleTalk 48
connecting 25

returning to recently-visited site 27
through AOL and Compuserve 27
through web browser 26
using bookmarks 26

connection window 25
conversation 37
Copy 49
costume 54
create new avatar 32
customize avatar 31
Cut 49
cyborg.ipt 49, 74

D
default Palace 51
delete prop 43
Delete prop 55
directory of Palaces 26
disconnecting 22, 48
Discussion Groups 57
Don’t Update User List 52
door 40

show outline 40
Download Graphics 51
Draw 52
drawing tools 58
drawing window 52
Duplicate Prop 55

E
Edit Menu 49
Edit Profile Page 50
Edit Prop 55
ESP 38
events 63
expression, change 30
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F
face icon 47
Face Picker window 30
Face Prop 56
fading 51
FAQ 57
File Menu 48
Find User 53
firewall requirements 12
Flip prop 56
Floating Log Windows 52
Font 51
font, set size 51
Full Screen 52

G
ghost 56
Ghost Prop 56
Go Back 52
Goto Room 41, 53
GoTo Site Page 53
Guest Avatars 54
guest log on 20

H
Help Menu 57
hot keys 57
hot spot 26, 40

I
Iconize 52
Icons 47
initial logon 19
Input Box 47, 57
installation 13
interface 45
InternetConfig

add applications 14
MIDI support 15
support 14

Iptscrae 73

K
keyboard shortcuts 57

L
log file 49
Log Window 52
Log window 39
logging off 22
logging on 19
logging on as guest 20
logging on as registered member 19
loose prop 41, 42

M
main window of The Palace 45
Member Avatars 54
member room 71
membership 49

membership activation 20
message, private 38
MIDI support 15
move prop 43
moving around 22, 40

N
name

change 30
set 51

newroom command 72

O
object, see prop
operator

entering password 54
menu 54
page 39

Operator Menu 54
Operator menu option 54
Options Menu 52
owner, entering password 54

P
page operator 39
Paint Palette, icon 47
Palace 26

commands 83
site page 53

Palace client
activate membership 20
commands 71
connecting through 25
connecting through Appletalk 27
connecting to sites 25
installing 13
interface 45
logging off 22
logging on as guest 20
logging on as registered member 19
logging on for first time 19
main window 45
PalacePresents plugin 63
password for child lock 49
plugins 54
Practice Palace 22
preferences window 22
requirements 11
returning to recently-visited server 27
set sound volume 52
setting default Palace 51
setting preferences 50
shortcut keys 57
show avatar names 51
upgrading 13
using online services 27
using Palace Directory 26
using speech 52

Palace Home Page 57
Palace Starts With 51
PalacePresents 63
Paste 50
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Paste Multiple props 50
Plugins 54
Practice Palace 22
preferences, window 50
preferences window 22
private messages 38
profile page, edit 50
prop 56

animate 56
bounce 56
change position of 44
create 43
create loose 42
create new 55
create non-copyable 56
definition 41
delete 43, 55
duplicate 55
edit 43, 55
face 56
flip 56
give background 56
loose 41
move 43
purge old 55
put in Prop Picker 43
rare 56
store 41
take copy of 43
wear 43

Prop Animations 51
Prop Editor 43, 55, 60
Prop Picker 60

put prop in 43
Prop Picker window 41
prop window, see Prop Picker
PropEdit menu 56, 62
Props Menu 55
Purge prop 55

Q
Quick Reference 57

R
Rare Prop 56
rclose command 73
rdelete command 72
registered member log on 19
registration code 20
Reload Script 49
requirements 11
rguests command 73
rhide command 73
rkick command 72
rname command 72
room

create member 71
create props for 42
go to specific 41, 53

Room List Window 53
ropen command 73
rowner command 72
rpainting 73

rpassword command 72
rpicture command 72
rscripts command 73
runhide command 73
runkick command 72

S
save avatar look 35
script 49
security 49
Select All 50
shouting balloon 38
Show Names 52
Show User Names 51
sign balloon 38
site page, go to 53
Size 51
socialize 37
Software Updates 57
sound, play 39
Sound Volume 52
Speak As 52
speech 52
Speech Manager, speak as 52
spiky balloon 38
spoof 38
spot 40
Status Bar 47
suitcase 60

icon 47

T
talk 22, 37
text, cut from window 49
thought balloon 38
Tinted Balloons 51
Trash Can icon 47
travelling 40
Tutorial 57
tutorial 22

U
Undo 49
upgrading client software 13
Use Fade Effects 51
User Guide 57
User List Window 53

don’t update 52
user, see avatar

V
View Screen 46, 57

W
walking 40
wear prop 43
wear avatar look 35
web browser, connecting through 26
Welcome Palace 20
Welcome Palace Gate 21
whisper 38
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